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 نام آفريدگار هستي به
 
 

 چه كه از وجود مباركش بر ما شناسانده، سپاس خداي را برآن
 چه از شكرش به ما الهام فرموده، و برآن

 .و برآن درهاي دانش كه به پروردگاريش بر ما گشوده
 
 
 

 مندان به راهسازيي علاقهتقديم به همه

 ويژه دانشجويان مهندسي عمران به
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 پيشگفتار
 

كه مـا    با وجود اين.  ي زيادي داشته استي مهندسي عمران است، در ايران پيشينههاي رشتهراهسازي كه يكي از گرايش
عدم توجه به .  ايرانيان از پيشگامان راهسازي در دنيا بوديم، اما امروزه شاهد كمبود متخصصان  اين رشته در كشور هستيم

هاي اخير و حركت بيشتر به سمت صنعت ساختمان، سبب شد كه امروزه علاوه بر كـمـبـود      گرايش راه و ترابري در سال
كسب درآمدهاي هنگفت در اين صنعت سبب شد گروهي . نيروي كارآمد، شاهد ورود نيروهاي غيرفني در اين رشته باشيم

ها به دلايلي نـيـروهـاي      ولي متأسفانه بعد از ورود اين سرمايه.  گذاران كشور به سمت راهسازي سوق پيدا كننداز سرمايه
آمـار زيـاد     .  علمي راهسازي از اين صنعت كنار گذاشته شدند و راهسازي غيرعلمي و غيراستاندارد در ايران رواج پيدا كرد

اميد است .  اي گواه اين ادعا استها، عدم كنترل صحيح ترافيك شهري و جادهاي، كوتاه بودن عمر آسفالت راهتلفات جاده
كارگيري دانش فني در ايـن      در آينده با تلاش و همكاري بيشتر نيروهاي فني اين رشته و ياري مسئولين كشور شاهد به

 .صنعت باشيم
افـزارهـاي   ها و نـرم   نامهورود ماشين آلات، آيين.  نصيب نگذاشتها راهسازي را نيز بيي زمينهپيشرفت تكنولوژي در همه

در دنياي فني و مهندسي امـروز لازم اسـت       .  كندروز دگرگون ميهاي علمي، روزبهجديد اين رشته را همانند ساير رشته
افـزارهـاي مـهـم در            يكي از نـرم .  افزارهاي جديد نيز متخصص بودي استفاده از نرمي تئوري، در زمينههاعلاوه بر زمينه

اسـت كـه هـرسـالـه                AutoCAD Land Development and Civil Designافزار   برداري نرمي راهسازي و نقشهزمينه
هايي نيز در اين زمينه نوشته شده كه بسيـار جـامـع و        بعد از ورود اين برنامه، كتاب.  آيدهاي جديد آن به بازار مينسخه

هـا فـقـط بـراي         اند و گاه موارد ذكر شده در آنها به صورت كتاب مرجع چاپ شدهاما چون اين كتاب.  كاربردي هستند
ي كاربردي را از ابتدا تا انتها كه يك پروژهكارهاي خاص كاربرد دارد، برآن شديم كه راهنماهايي تهيه كنيم كه علاوه بر آن

راهنماي حاضر اولين .  افزاري نيز باشدهاي كامپيوتر و ايجاد ارتباط بين طراحي دستي و نرمدهد، شامل تحليل دادهانجام 
ي راهسازي را به صورت تئوري و گام به گـام    يك پروژه 91ي اين سري است كه پس از تجديد نظر نهايي در سال نسخه

ي كارشناسي ارائـه  به همين دليل سعي شده مطالب در قالب درس راهسازي دوره.  دهدافزار انجام ميتوضيح داده و با نرم
 . شده و از پرداختن به مطالب تخصصي خودداري شود

جـا لازم    در ايـن   .  افزاري ارائه كنيمتري را از لحاظ علمي و نرمهاي بعدي اين راهنما مطالب تخصصياميد است در نسخه
پور، محمدصادق تيموري و محمدحسين پور، علي شيرازياست از جمعي از دوستانم، آقايان احسان يعقوبي، جواد شيرازي

عضو هيئت علمـي دانشـگـاه      ( كمالي خسروشاهي كه در اين زمينه مرا ياري كردند و نيز اساتيد گرانقدرم، مهندس جلال
 .كمال تشكر و سپاس را داشته باشم) استاد دانشگاه علم و صنعت ايران(و پروفسور حميد بهبهاني) شهيد باهنركرمان

 
       
  

                                                                    

 91شهريور 

 احسان آزادروش

Farno_co@ymail.com 

 دانشگاه علم و صنعت ايران -ارشد راه و ترابريكارشناسي
 و مدرس دانشگاه آزاد اسلامي واحد كرمان



5 

 افزارساخت پروژه در محيط نرم -1

 .را انتخاب كنيد Newي گزينه Fileدر منوي * 
 .شودباز مي New Drawing: Project Basedاي با عنوان صفحه* 
 .تايپ كنيد Drawingنامي براي  ،Nameدر قسمت * 
 .را كليك كنيد Create Projectي گزينه* 
 .شودباز مي Project Detailsاي با عنوان صفحه* 
 .را انتخاب كنيد Metersي ، گزينهFeetبجاي  Prototypeدر قسمت * 
 .ي كليدي را به دلخواه وارد كنيد، نام و توصيف و كلمهProject Informationدر قسمت * 
 دار است، آن را تغيير ندهيدفرض تيكبه صورت پيش Project “DWG” Folderي ، گزينهDrawing Pathدر قسمت * 
 *Ok را كليك كنيد. 
 .را كليك كنيد Okنيز  New Drawing: Project Basedي در صفحه* 
 .را كليك كنيد Next. شودباز مي Load Settingاي با عنوان صفحه* 
ي        ، گـزيـنـه     Angle Display Styleو در قسـمـت          Metersي ،گزينهLinear Units، در قسمت Unitsي در صفحه*  

North Azimuths ي پيغام اخطار، آن را در صورت مشاهده. را انتخاب كنيدOk  كرده و صفحه راNext كنيد. 
حـال  .  انتخـاب كـنـيـد        Drawing Scaleرا براي مقياس افقي و قائم در قسمت  Customي ، گزينهScaleي در صفحه* 

.     برابر آن را براي مقياس قائم درنظرگرفته و مطابق مـثـال وارد كـنـيـد          10ي توپوگرافي و در نتيجه مقياس افقي نقشه
محـسـوب    1:500و براي مقياس قائم كه  5000عدد  Horizontalدر كادر . است 1:5000فرض كنيد مقياس افقي : مثال
 .كنيد Nextصفحه را . را وارد كنيد 500عدد  Verticalشود در كادر مي
 .كنيد Nextي ايران را انتخاب و صفحه را ، ناحيهCategoriesاز منوي  Zoneي در صفحه* 
 .كنيد Nextرا  Orientationي صفحه* 
را انتخاب و صفحـه   5MMرا انتخاب و سپس   milli.stpي ، گزينهStyle Set Nameدر منوي  ،Text Styleي در صفحه* 
 .كنيد Nextرا 
 .كنيد Nextرا  Borderي صفحه* 

بـه ايـن     .  را كليك كـنـيـد    Saveي ، نامي براي فايل اطلاعات وارد شده انتخاب كرده و گزينهSave Settingي در صفحه
اي با همين مشخصات بسازيد، در همان ابتداي مراحل ساخت كه در بالا ذكر شـد، در    ترتيب اگر دوباره مايل بوديد پروژه

را كليك كنيد و بعـد   Finishدر پايان . را فشار دهيد Loadي روي همان نام كليك كرده و گزينه Load Settingي صفحه
 . كنيد Okكردن پيغام ظاهر شده، آن را از چك

ي موردنياز براي نام و توصيـف نـقـاط      ي اندازهدهندهشود كه نشانباز مي Create Point Databaseاي با عنوان صفحه* 
قرار بگيريد تا   File> Saveي اصلي منوي حال در صفحه. كنيد Okدار كرده و صفحه را را تيك Use Point Names. است

 .افزار ساخته شدي ما در محيط نرمبا اين عمليات محيط پروژه. اطلاعات ذخيره شود

 افزاري توپوگرافي به نرممعرفي نقاط نقشه -2

 و   Excelهاي   يا در محيط برنامه Landافزار هاي متعددي مثل وارد كردن دستي نقاط در محيط نرمبراي اين كار روش
Accessجـا روش     هاي تبديل تصوير اسكن شده به بردار و روش اسكن مستقيم وجود دارد كه در ايـن   ، استفاده از برنامه



6 

. كنيمي اطراف آن را اسكن ميي توپوگرافي شامل نقاط اجباري و محدودهابتدا قسمتي از نقشه. اسكن مستقيم آمده است
لازم بـه ذكـر     .  بهتر ابتدا اين محدوده را با يك مستطيل روي نقشه مشخص كرده و سپس همين محدوده را اسكن كنيد

ي اسـكـنـر      كه صـفـحـه     در صورتي.  ي اسكن شده بزرگتر باشد، در مسيريابي دست كاربر بازتر استاست هرچه محدوده
 .توان با دوبار اسكن كل محدوده را پوشش دادي نقشه باشد، ميكوچكتر از محدوده

 :كنيمي ساخته شده باز ميحال تصوير يا تصويرهاي اسكن شده را در محيط پروژه* 
ي بـاز شـده،       افزار، كليك نموده و در پنجـره در گوشه سمت راست نرم  Workspaceبر روي آيكن  1-2ابتدا مانند شكل 

Land Desktop Complete را انتخاب كنيد. 
 .كنيد Openي اسكن شده را انتخاب و سپس فايل نقشه. را انتخاب كنيد Raster Imageي گزينه Insertدر منوي * 
. را فشار دهيـد  2-2ي سمت چپ شكلدر گوشه Detailsي در اين پنجره گزينه. شودباز مي 2-2اي مطابق شكلپنجره* 

ي اسكن صفحه) Height(و ارتفاع) Width(عرض ،Image size in unitsدر بخش . شوديك قسمت در زير پنجره اضافه مي
 .باشد) Meters(سيستم بر حسب متر Current AutoCAD unitكنترل كنيد كه در قسمت . شده را يادداشت كنيد

كش اندازه گرفته و بعد از تبديـل  ي توپوگرافي با خطايد از روي نقشهاي را كه اسكن كردهحال عرض و ارتفاع محدوده*  
بـراي دقـت     .  ي اسكن شده بـاشـد  گيري بايد دقيقا براساس محدودهدقت كنيد كه اين اندازه.  به واحد متر يادداشت كنيد

براي اين كار بـعـد از بـاز        .  گيري كنيداندازه  Microsoft Office Wordي توانيد تصوير اسكن شده را در برنامهبيشتر مي
 Measurementي كشويـي    از جعبه Generalقرار گرفته و در قسمت   Tools> Options، در مسيرWordي كردن برنامه

Units ي گزينهCentimeters حال منوي .  را انتخاب كنيدInsert> Picture> From File        را اجرا كرده و تصويـر اسـكـن
را انتخـاب    Format Pictureسپس روي تصوير راست كليك كرده و قسمت .  را كليك كنيد Insertشده را انتخاب كرده و 

هاي ، اندازهOriginal Sizeي باز شده در بخش در قسمت پايين پنجره. را انتخاب كنيد Sizeي باز شده در صفحه.    كنيد
 .ها را يادداشت كنيدآن. متر آمده استدقيق تصوير برحسب سانتي

 .كنيد OKرا  2-2ي شكل پنجره* 
 :شوددر خط فرمان پيغام زير ظاهر مي* 

Specify insertion point <0,0>: 

 . اي براي ورود تصوير انتخاب كنيدبا كليك كردن بر روي صفحه، نقطه* 
 :شوددر خط فرمان پيغام زير ظاهر مي* 

Specify scale factor <1>: 

كـش           گـيـري شـده بـا خـط           اگر عرض و ارتفاع اندازه.  حال اعداد عرض و ارتفاع يادداشت شده را با هم مقايسه كنيد*  
بعد از تبديل به واحد متر با عرض و ارتـفـاع نـوشـتـه شـده در قسـمـت                               Wordي ي توپوگرافي يا برنامهروي نقشه

Image size in units مساوي بودند، در جـواب     1-2ي شكل پنجرهSpecify scale factor <1>:            كـافـي اسـت
Enter  گيـري بـا     ولي اگر اين اعداد متفاوت بودند بايد عدد عرض به دست آمده از راه اندازه.  پذيرفته شود 1كنيد تا عدد

تقسيم كنيد و     1-2ي شكلرا بعد از تبديل به واحد متر بر عدد عرض يادداشت شده از پنجره Wordي كش يا برنامهخط
مثلا در بعضي حالات مـمـكـن      .  عدد حاصل از تقسيم را وارد نماييد :<Specify scale factor <1در جواب پيغام 

 Wordي   كـش يـا بـرنـامـه         گيري شده با خـط باشد و عرض اندازه)  يك( 1، عدد 1-2ي شكلاست عدد عرض در پنجره
     0/2تقسيم كنيد كه حـاصـل هـمـان          1را بر )  برحسب متر( 0/2در اين حالت كافي است .  متر باشد0/2متر يا سانتي20
 .كنيد Enterدر خط فرمان وارد و  :<Specify scale factor <1شود و اين عدد را در جواب پيغام مي
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 افزار، ورود تصوير اسكن شده به محيط نرم2-2شكل 

 .روي آن زوم كنيد. شودافزار ميبه اين ترتيب تصوير اسكن شده وارد محيط نرم* 
 .را انتخاب كنيد Polyline، ابزار Drawو يا از منوي  AutoCADحال از نوار ابزار * 
اي كه مسيرهاي هاي ميزان تصوير اسكن شده و در محدودهكردن روي تصوير، برروي منحنيبا دقت و با استفاده از زوم*  

هـاي خـوانـده      هرچه دقت اين كار بيشتر باشد تعداد نقطه.  بكشيد   Polylineكنند،انتخابي شما براي طراحي راه عبور مي
 .شودافزار بيشتر ميشده در مراحل بعدي توسط نرم

 .رسم شد، تصوير اسكن را پاك كنيد Polylineنظر تصوير اسكن شده هاي ميزان موردكه روي منحنيپس از آن* 
 Scaleتوانـيـد از آيـكـن           براي اين كار مي.  را اجرا كنيد Scaleكرده و سپس دستور  Selectها را Polylineحال كل *  

 .كنيد Enterرا در خط فرمان تايپ كرده و  Scaleي كه كلمهاستفاده كنيد و يا اين
 :شوددر خط فرمان پيغام زير ظاهر مي* 

Specify base point: 

 .ها كليك كنيدPolylineاي از روي نقطه* 
 :شوددر خط فرمان پيغام زير ظاهر مي* 

Specify scale factor or [Reference]: 

 .كنيد Enterوارد كرده و  5000است، عدد را  1:5000مثلا اگر مقياس . در جواب اين پيغام، عدد مقياس را وارد كنيد* 
 .هاي ميزان در صفحه ديده شوندي منحنيرا اجرا كنيد تا همه View> Zoom> Extentsدستور * 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 Workspace، پنجره 1-2شكل 
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در خط فرمان پيغـام  .  را انتخاب كنيد  Edit Elevationي و سپس گزينه  Contour Utilitiesي گزينه Terrainاز منوي * 
 .شودانتخاب منحني ميزان ظاهر مي

Select contour: 

ي تـوپـوگـرافـي در جـواب پـيـغـام                                    اولين منحني ميزان را انتخاب و سپس كد ارتفاعي آن را با توجه بـه نـقـشـه      *  
New elevation <0.000>:  وارد كرده وEnter كنيد. 

 Enterمنحني ميزان بعدي را انتخاب و كد ارتفاعي آن را وارد كرده و .  شوددوباره پيغام انتخاب منحني ميزان ظاهر مي*  
ي دقت كنيد كه ارتفاع صحيح را با توجه بـه نـقـشـه      .  دار كنيدهاي ميزان را ارتفاعي منحنيبه همين ترتيب بقيه.  كنيد

 .توپوگرافي وارد كنيد
.                      فـعـال بـاشـد        Nearestي   گزينـه ، Osnap Settingهاي ميزان لازم است كه در دقت كنيد كه براي انتخاب منحني �

Osnap Setting ، با گرفتنShift شـود        ي بـاز شـده، ظـاهـر مـي           ، در انتهاي پنجرهو راست كليك كردن بر روي صفحه
 .دار كنيدرا تيك Endpointو  Nearest) 4-2شكل(ي باز شدهآن را انتخاب كرده و در پنجره). 3-2شكل (
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                     3-2شكل  

 Osnap Settingانتخاب 
 Nearest، انتخاب 4-2شكل 
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 ساخت سطح -3

هـاي مـيـزان يـك         در خط فرمان و يا با استفاده از آيكن آن اجرا كرده و دور منحنـي  plرا با تايپ  Polylineدستور *  
Polyline براي اين كار لازم است كه در.  دقت كنيد كه ابتدا و انتهاي آن دقيقا به هم برسند.  رسم كنيدOsnap Setting            ،  

 .پذير نيستروي هم نيفتد، ساخت سطح امكان Polylineكه ابتدا و انتهاي در صورتي. روشن باشد End Pointي گزينه
 .را اجرا كنيد Terrain> Terrain Model Explorerدستور * 
 .را كليك كنيد  Create New Surfaceراست كليك كرده و  Terrainي روي پوشه) 1-4شكل(ي باز شدهدر صفحه* 
 .ظاهر شود Surface1ي كليك كنيد تا گزينه Terrainي كنار پوشه+ روي علامت * 
 ).1-3شكل(هاي آن ظاهر شوندكليك كنيد تا گزينه Surface1ي كنار پوشه+ روي علامت * 
 .را كليك كنيد  Add Contour Dataراست كليك كرده و  Contoursها روي در اين گزينه* 
 :كرده تا در خط فرمان پيغام زير ظاهر شود  OKرا  Contour Weedingپنجره * 

Select objects by [Entity/Layer] <Layer>: 

 .انتخاب مي شود  Entityدر خط فرمان گزينه  eبا تايپ حرف 
 Enterپس از انتخاب منحني هاي ميـزان    . حال مي توان منحني هاي ميزان را تك تك و يا به صورت كلي انتخاب نماييم

 .باز گرديد  Terrain Model Explorerنماييد تا به ينجره 
ي اصلـي  حال در صفحه.  را انتخاب كنيد Add Boundary Definitionراست كليك كرده و  Boundariesي روي گزينه* 

نام دلخواه را در خط فـرمـان وارد       .  ، كليك كنيد) كه در مراحل قبلي رسم كرديد( هاي ميزاندور منحني Polylineروي 
كـردن   Enterاست و با  Outerافزار همان فرض نرمپيش( وارد نماييد Outerكنيد و نوع آن را در خط فرمان  Enterكرده، 

را    Escحال كليد ).  باشدمي Yesافزار فرض نرمپيش( كنيد Enterها را در لبه Breaklinesپيغام ساخت ).  شودانتخاب مي
 .را كليك كنيد Buildي راست كليك كرده و سپس گزينه Surface1روي  1-3ي شكلزده و در  پنجره

دار كـرده و كـل         را تيـك   Minimize flat triangles resulting from contour dataي ي ظاهر شده گزينهدر صفحه* 
 .را ببنديد Terrain Model Explorerي كنيد و سپس صفحه Okرا  Done Building Surfaceپيغام . كنيد Okصفحه را 

كه بعد از ساخت سطح يا در مراحل بعد از آن كه در ادامه آمده است متوجه شـديـد در وارد كـردن          درصورتي:  نكته*  
و سـپـس       Contour Utilitiesي   ،گزينـه  Terrainتوانيد از طريق منوي هاي ميزان اشتباهي كرديد، ميارتفاعات منحني

پس از تصحيح ارتفاعات نياز است كه در  سطح .  را انتخاب كرده و ارتفاع وارده را تصحيح نماييد  Edit Elevationي گزينه
 .را بر روس سطح انجام دهيد Buildهاي ميزان را مجددأ انتخاب كرده و عمل منحني Contours ساخته شده، در گزينه
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 هاي افقيرسم مسير و طراحي قوس -4

در اين مرحله بايد حداقل سه مسيـر را مـورد       .  ي راهسازي استمسيريابي يكي از مهمترين مراحل پروژه:  رسم مسير*  
قبل از انتخاب مسيرها لازم   .  ها بهترين مسير را از نظر شرايط اقتصادي و ايمني انتخاب گرددارزيابي قرار داد و از بين آن

. ي توپوگرافي مسيرهاي شكسته را رسم كنيم تا از حدود قرارگيري راستاهاي مسير مطلع شويـم است كه ابتدا روي نقشه
اي بـاز  ي پرگار را بايد به اندازهاساس كار اين است كه دهانه.  دهيمدانيد اين كار را با روش پرگار انجام ميهمانطور كه مي

براي پيدا كردن مقدار باز .  كرد كه شيب طولي براي رفتن از يك منحني تراز به منحني تزار ديگر از حد مجاز بيشتر نشود
 .ي پرگار از فرمول مقابل استفاده كنيدكردن دهانه

 
 :در اين فرمول داريم

Lmin =متر(حداقل طول براي رفتن از يك منحني تراز به منحني تراز ديگر با حفظ شيب مجاز( 
i2 =ارتفاع بزرگتر(رقم ارتفاعي منحني تراز( 
i1 =ارتفاع كوچكتر(رقم ارتفاعي منحني تراز( 
i =مثلا اگر . عدد را با مقدار صدم در فرمول بگذاريد(شيب مجازi=8%  دهيدرا قرار 0/08باشد در فرمول عدد( 

كه بخواهيد خطوط شكسته را  در محيط در صورتي.  دهدرا برحسب متر و در روي زمين واقعي مي Lminفرمول بالا مقدار 
AutoCAD ولـي اگـر     .  ي پرگار همين مقدار استي شعاع دايره يا همان دهانههاي تراز رسم كنيد، اندازهبر روي منحني

 .ي توپوگرافي رسم كنيد از فرمول زير استفاده كنيدبخواهيد خطوط شكسته را روي نقشه
 
 

 . دهدي توپوگرافي ميمتر بر روي نقشهرا برحسب سانتي Lminاين فرمول همانند فرمول بالاست با اين تفاوت كه مقدار 
 

 ، ساخت سطح1-3شكل 

2 1

min

i i
L

i

−
=

2 1

min

i i
L ( Scale) 100

i

−
= × ×
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ي مقياس نـقـشـه      Scaleدر اين فرمول .  ي پرگار را به اين اندازه باز كنيددر واقع براي رسم دستي خطوط شكسته دهانه
 . توپوگرافي است

 :مثال
متر به خط تراز ديگري به ارتفـاع  2110از يك خط تراز به ارتفاع %  8خواهيم در يك منطقه با شيب مجاز فرض كنيد مي

 .است 1:5000متر برويم و مقياس نقشه 2115
 :داريم) هايا كمان(هابراي شعاع دايره AutoCADدرصورت رسم با 

 
 :ي پرگار داريمي توپوگرافي براي دهانهو با روش دستي روي نقشه

  
 

.        كـنـد  شود، كمان رسم شده خط تراز بعدي را قطع نـمـي    ي خطوط تراز زياد ميدقت كنيد گاه در مناطقي كه فاصله*  
در مواردي كه خطوط تـراز      .  هاي دايره را كه تا خط تراز بعدي ادامه دهيد، قابل قبول استدر اين حالت هركدام از شعاع

ي نسبتا دوري از خط تراز بعدي قرار      آيد كه كمان زده شده در فاصلهشوند، اغلب حالتي پيش ميبه هم بسيار نزديك مي
 .گيرد و براي رفتن به خط تراز بعدي و حفظ شيب مجاز به ترانشه احتياج داريممي

ي اجباري و يا انتهاي مسير نزديكتر در دو مورد قبل سعي كنيد شعاعي را از دايره انتخاب كنيد كه مسير را به سمت نقطه
.    ي پرگار را كمتر از آن بـاز كـرد      كمترين طول لازم براي حفظ شيب مجاز است، بنابراين نبايد دهانه Lminمقدار . كندمي

 .اي را بدون رفتن به منحني بعدي طي كنيدتوانيد فاصلهدر روي يك منحني تراز مي
اي بكشيد كه از نقـاط  گونهرا اجرا كرده و راستاي مسير را به Line/Curves> Lineبعد از رسم خطوط شكسته، دستور *  

ي برخـورد  دقت كنيد كه نقطه.  اي كه با روش پرگار رسم كرديد، باشدي خطوط شكستهاجباري عبور كرده و در محدوده
.   ها، مسير از نقاط اجباري عبور نخواهد كـرد   راستاهاي مسير نبايد بر نقاط اجباري منطبق باشد چرا كه بعد از رسم قوس

بندي، مسير بهينه را انـتـخـاب    ي حداقل بايد سه مسير درنظرگرفت و سپس براساس يك بارمبه طوركلي براي يك پروژه
بندي كه باعث دشواري بندي بسته به شرايط پروژه و براساس نظر مهندس طراح، ابتدا عوامل مؤثر در بارمدر اين بارم. كرد

اي از ايـن عـوامـل      پاره.  گيردشود را تعيين كرده و به هركدام يك امتياز منفي تعلق ميساخت و يا كاهش ايمني راه مي
ي فني مثل پل و تونـل، ارتـفـاع      ها، حجم عمليات خاكي، مخارج راه، وجود ابنيهطولاني بودن راه، تعداد قوس:  عبارتند از

امتياز  3مثلا به ازاي هر كيلومتر راه ( هاي طولي بالاتر از حد مجاز و موارد مشابه زياد خاكبرداري و خاكريزي، تعداد شيب
بندي براي هر مسير جمع نمرات منفي محاسبه شده و مسيـري  پس از بارم).  امتياز منفي 10منفي يا به ازاي وجود تونل 

تواند متفاوت بـاشـد و          اين موارد در هر پروژه مي.  شودي منفي را دارد به عنوان مسير بهينه انتخاب ميكه كمترين نمره
بندي لازم نيست مسيرهاي نامزد شده را به طور كامل و لازم به ذكر است كه براي بارم. به نظر مهندس طراح بستگي دارد

اي، رسـم  هاي افقي دايرهبندي براي هر مسير يك طراحي ساده شامل قوسدقيق طراحي كنيد بلكه با توجه به موارد بارم
هاي نياز به طراحي قوس ) بنديي بارممرحله( در اين مرحله.  پروفيل طولي و انجام محاسبات عمليات خاكي را انجام دهيد

 .    باشدقائم و رسم منحني بروكنر بهينه نمي
 

min

2115 2110
L 62.5m

0.08

−
= =

min

2115 2110 1
L ( ) 100 1.25cm

0.08 5000

−
= × × =
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:        براي ايـن كـار دو روش وجـود دارد             .  كنيمهاي افقي مسير را رسم ميدر اين مرحله قوس:  هاي افقيطراحي قوس*  
 قوس كلوتئيد) قوس ساده ب) الف
 :قوس ساده) الف
 .را اجرا كنيد  Line/Curves> Curve Between Two linesدستور * 
 .روي مماس اول كليك كنيد. شوددر خط فرمان دستور انتخاب اولين مماس ظاهر مي* 
 .مماس دوم را انتخاب كنيد. شودسپس دستور انتخاب دومين مماس ظاهر مي* 
 Enterفرض اين فاكتور، فاكتور شعاع است و كافي است بصورت پيش. شوددر خط فرمان نوع فاكتور طراحي پرسش مي* 

 .را فشار دهيد
FACTOR [Length/Tangent/External/Degree/Chord/Mid/MDist/<Radius>]: 
 

 .شوددر خط فرمان مقدار شعاع خواسته مي* 

Radius: 

 .براي انتخاب شعاع حداقل از فرمول زير استفاده كنيد. شعاع طراحي را وارد كنيد* 

)4-1( 
 :در اين فرمول داريم* 

 V = كيلومتر بر ساعت(سرعت طراحي قوس( 

 e =وِري ، بر اساس توصيه%8، در استاندارد ايران )برِبلندي يا حداكثر شيب عرضي در قوس(دB.C.E.O.M  7  % و بر اساس

بـراي مـنـاطـق       %  10براي مناطق معتدل سرد، %  8براي مناطق سردسير، %  6)  وهواييبراساس شرايط آب( ي آشتوتوصيه

را قرار  0/08باشد در فرمول عدد  e=8%مثلا اگر . را با صدم بگذاريد eدر فرمول . براي مناطق گرمسير% 12معتدل گرم و 

 .دهيد

 f  =1-5ضريب اصطكاك جانبي از جدول   

 

 

 

 

Rmin =شعاع حداقل طراحي قوس برحسب متر 
اختيار  1-4از مقدار حاصل از فرمول شود كه سعي كنيد مقداري بيش، حداقل شعاع طراحي محاسبه مي1-4از فرمول *  

 .گرددتر ميتوجه داشته باشيد هرچه شعاع قوس بزرگتر باشد، طول قوس بيشتر شده ولي مسير كوتاه. كنيد

2

min

V
R

127(e f )
=

+

V (km/h) 

 130 120 110 100 90 80 70 60 50 40 سرعت طراحي

f 

 0/09 0/10 0/10 0/11 0/12 0/13 0/14 0/16 0/20 0/25 ضريب اصطكاك

 ، ضريب اصطكاك جانبي1-4جدول 
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 .گرددكرده، قوس رسم مي Enterبعد از وارد كردن شعاع موردنظر * 
 :روابط قوس ساده به قرار زيرند* 
)4-2( 
 
)4-3( 
 
 
)4-4( 
 
)4-5( 
 
)4-6( 

 ):1-4شكل(در اين روابط داريم* 
T =طول مماس 
E =طول خارجي 
M =طول مياني 
C  =طول وتر(Chord) 
S =طول قوس 

 ي بين دو مماسزاويه= 
 .انداين پارامترها نشان داده شده 1-4در شكل * 
 .اي ساده است، آمده استدر قسمت قوس كلوتئيد يك مثال براي قوس وسط اتصال كلوتئيدي كه يك قوس دايره* 
 
 

T R tan
2

∆
=

1
E R( 1)

cos
2

= −
∆

M R(1 cos )
2

∆
= −

C 2Rsin
2

∆
=

R
S

180

∆π
=

∆

 ، اجزاي قوس ساده1-4شكل 
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 :قوس كلوتئيد) ب
را  Clothoid، ) 2-4شكل( ي ظاهر شدهرا اجرا كرده و در پنجره Line/Curves> Create Spirals> Spiral Typeدستور * 

 .كنيد Okدار كرده و پنجره را تيك
 
 
 
 
 
 
 

 . را اجرا كنيد Line/Curves> Create Spiral> Fit Tangent-Tangentدستور * 
 .كنيد  OKرا   Spiral Curve Spiralگزينه ) 3-4شكل (در پنجره باز شده 

 :شودپيغام زير در خط فرمان ظاهر مي
Select line (or POints): 

 :شوددوباره همان پيغام ظاهر مي. مماس اول را انتخاب كنيد 
Select line (or POints): 

هـا  فعال باشد تا بـراحـتـي مـمـاس        Nearest يگزينه، Osnap Settingلازم است كه در (حال مماس دوم را انتخاب كنيد
 ).انتخاب شوند

 :پس از انتخاب مماس دوم پيغام زير در خط فرمان ظاهر مي شود * 
Enter radius (or Degree): 

 :شوداي وسط از فرمول زير حساب ميشعاع قوس دايره* 
 
)4-7( 
 

 .كنيمشعاع قوس را حساب كرده و مقداري بيشتر از عدد محاسبه شده را در خط فرمان وارد مي
 :پيغام زير در خط فرمان ظاهر مي شود 

Spiral A in (or Length): 

براي اين كار كافي است در .را انتخاب كنيم Lengthبراي وارد كردن طول كلوتئيد نياز است تا در پيغام ظاهر شده گزينه 
 :پيغام زير در خط فرمان ظاهر مي شود . را تايپ كرده تا پارامتر طول كلوتئيد انتخاب گردد lخط فرمان حرف 

Spiral Length in (or A): 

 :ي زير انتخاب كنيدطول اتصال كلوتئيدي را از بزرگترين مقدار دو رابطه* 
 
)4-8( 
 
 

 )مارپيچ(، نوع اسپيرال2-4شكل 

2

cmin

V
R

127(e f )
=

+

s1

3
s

s2

c

l 13.65Ve

l Max 0.036V
l

R

= 
 

=  
= 
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 :در اين روابط داريم* 
V =سرعت طراحي برحسب كيلومتر بر ساعت 
Rc =اي وسط بر حسب مترشعاع قوس دايره 
 e =وِر يا برِبلنديد 
ls  =طول اتصال كلوتئيدي بر حسب متر 
f = 1-4ضريب اصطكاك جانبي از جدول  

 :باشد، داريم V=60km/h ،e=0.06 ،f=0.16طور مثال اگر به* 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 .متر را وارد مي كنيم  60براي مثال مقدار 
 :در خط فرمان پيغام زير ظاهر مي شود 

Spiral Length out (60.0000) (or A): 

در صورتـيـكـه    .  همانطور كه مشاهده مي كنيد طول اتصال خروجي به صورت پيش فرض مشابه طول اتصال ورودي است
Enter  متر نيز براي طول اتصال خروجي انتخاب مي شود اما در صورتي كه مقدار ديگري مد نظر باشـد   60نماييد مقدار

 . مي توانيد آنرا وارد نماييد 

 .شودقوس كلوتئيد رسم مي* 

 ، انتخاب نوع قوس3-4شكل 

2

cmin

c

60
R 128.85m

127(0.06 0.16)

R 300m

= =
+

=

s1

3
s s

s2

l (13.65)(60)(0.06) 49.14m

l Max l 49.14m0.036(60)
l 25.92m

300

= = 
 

= ⇒ = 
= = 

 



16 

افـزار مـقـايسـه                 در اين مرحله ابتدا پارامترهاي قوس كلوتئيد را با روش دستي محاسبه كرده و سپس با محاسبات نرم*  
 :روابط اين پارامترها در زير آمده. كنيممي

)4-9( 
 
)4-10( 
 
)4-11( 
 
)4-12( 
 
)4-13( 
 
)4-14( 
 
)4-15( 
 
)4-16( 
 
)4-17( 
 
)4-18( 
 

 :در اين روابط* 
Rc =اي وسط برحسب مترشعاع قوس دايره 
D =قوس برحسب درجهي درجه 
ls =طول اتصال كلوتئيدي برحسب متر 

 ي كلوتئيد برحسب درجهزاويه=  
xs =طول انتهاي كلوتئيد نسبت به شروع كلوتئيد 
ys =بعد انتهاي كلوتئيد نسبت به شروع كلوتئيد 
P =نشست(ي مماس تا مماس بر دايرهفاصله( 
 
 
 

s

s

l D

2 0
θ =

2 2 4 7 6 12 8 17s

s s s s s

l
x (100 0.3 (10) 0.43 (10) 0.3 (10) 0.14 (10) )

100

− − − −= − θ + θ − θ + θ

3 4 5 9 7 15s

s s s s s

l
y (0.58 0.13 (10) 0.12 (10) 0.05 (10) )

100

− − −= θ − θ + θ − θ

s c c s
P y R R cos= − + θ

s c sk x R sin= − θ

c

1
E (R P)( 1) P

cos
2

= + − +
∆

s c s cT x R sin (R E)sin
2

∆
= − θ + +

s

s

y
ST

sin
=

θ

s

s

s

y
LT x

tan
= −

θ

s cA l R=

sθ
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k =ي مركز دايره تا شروع كلوتئيدفاصله 
E =طول خارجي كلوتئيد 
T =طول مماس كلوتئيد 

 ي بين دو مماسزاويه= 
ST =مماس كوچك 
LT =مماس بزرگ 
A =پارامتر كلوتئيد 
 .انددر شكل زير اين پارامترها نشان داده شده* 
 
 
 
 
 
 
 
 
 
 
 
 
 

 .قرار دهيم، خواهيم داشت 18-5تا  9-5كه اعداد محاسبه شده در مراحل قبلي را در روابط در صورتي*  
 

∆

c

s

s

s

s

R 300m

l 49.14m

D 1.91

4.69

x 49.108

y 1.337

=

=

=

θ =

=

=

o

o

P 0.331

k 24.656

E 66.637

T 234.859

ST (Short T angent ) 16 .35

LT (Long Tangent ) 32 .81

A 121.42

=

=

=

=

=

=

=

 ، اجزاي قوس كلوتئيد4-4شكل 
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 .را اجرا كنيد Inquiry> Line/Curve/Spiralدستور * 
 :شوددر خط فرمان دستور زير ظاهر مي* 

Select entity (or POints) 

 .اي وسط كليك نكنيددقت كنيد كه روي راستا يا قوس دايره. روي اتصال كلوتئيدي كليك كنيد* 
. ي ظاهر شده اطلاعات قوس كلوتئيد آورده شده استدر پنجره. را اجرا كنيد View> Display> Text Windowدستور * 

 .كپي كرده و پرينت گرفت (Text Document)توان بر روي يك فايل متنياين اطلاعات را مي
 
 
 
 
 
 
 
 

 .         باشدميهـمـان    Thetaدقت كنيد . افزار همخواني داردشود مقادير دستي با محاسبات نرمهمانطور كه ديده مي* 
 

اي وسـط ظـاهـر             اطلاعات قوس دايـره     Text Windowي در پنجره.  اي وسط كليك كنيدحال اگر برروي قوس دايره*  
 .توانيد استفاده كنيداي ساده كه در قسمت قبل آمد نيز مياز اين روش براي قوس دايره. شودمي

 
 
 
 
 
 

جا برخلاف قوس دقت كنيد در اين.  انداي از روابط زير قابل محاسبهي مركزي قوس دايرهطول قوس، شعاع، وتر و زاويه*  
 :مساوي نيست و داريم) ي بين دو مماسزاويه(با  )  اي وسطي مركزي قوس دايرهزاويه(   Deltaساده، 

 

 
 .افزاري همخواني دارندجا نيز محاسبات دستي و نرمشود در اينهمانطور كه مشاهده مي* 

SPIRAL DATA: Clothoid 
-------------------------------------------------------------------------------- 

TS . . . .  North: 5292.752             East: -10281.870 
SPI. . . .  North: 5320.891             East: -10265.072 
SC . . . .  North: 5334.231             East: -10255.548 

               K : 24.565                 P : 0.335 
               A : 121.417              Tau : 0.082 
               Xs: 49.107                 Ys: 1.341 

        Long Tan : 32.772             Course: 30-50-05 
        Short Tan: 16.390             Course: 35-31-38 

Length: 49.140             Radius: 300.000           Theta: 4-41-33 

sθ

s
Theta 4 41'36" 4.69= θ = =o o

 ARC DATA 
-------------------------------------------------------------------------------- 

Begin . . . . .  North: 5334.231             East:  -10255.548 
Radial Point. .  North: 5159.904             East:  -10011.396 
End . . . . . .  North: 5458.182             East:  -9979.298 
PI  . . . . . .  North: 5476.944             East:  -10153.649 

   Tangent: 175.358           Chord: 302.784          Course: 65-50-05 
Arc Length: 317.379          Radius: 300.000           Delta: 60-36-54 

∆

sDelta 2

Delta 70 2(4.69) 60.62

Delta 60 36 '54" 60.615

= ∆ − θ

= − =

= =

o

o o

c

Delta
T(Tangent) R tan

2

60.62
T 300 175.376

2

=

= =

c

Delta
C(Chord) 2R sin

2

60.62
C 2(300)sin 302.807

2

=

= =

c(Delta )(R )
S Arc Lenght

180

(60.62)(300)
S 317.406

180

π
= =

π
= =
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 افزارمعرفي مسير به نرم -5

را اجرا كرده و در نزديكي ابتداي مسير، روي مسير كـلـيـك كـنـيـد                    Alignments> Define From Objectsدستور* 
 ).فعال باشد تا مسير براحتي انتخاب شود Nearest يگزينه، Osnap Settingلازم است كه در (

 .شوددر ابتداي مسير علامت ضربدر ظاهر مي* 
ي مسير ظاهر شـد، دسـتـور      كه اين علامت در ميانهدرصورتي.  دقت كنيد كه علامت ضربدر بايد در ابتداي مسير باشد*  

 .تعريف مسير را از اول اجرا كرده و سعي كنيد در نزديكي ابتداي مسير روي مسير كليك كنيد
 .شودچين ميبا انتخاب هر قسمت، بخش انتخاب شده خط. هاي ديگر مسير را انتخاب كنيدتكه به ترتيبحال * 
). اتصال كلوتئـيـدي    -ايقوس دايره  -اتصال كلوتئيدي( هاي كلوتئيد شامل سه قسمت مجزا هستنددقت كنيد كه قوس*  

 .ها را انجام دهيد تا هيچ بخشي از قلم نيفتدبراي دقت كافي سعي كنيد در حالت زوم شده انتخاب
 .را فشار دهيد Enterبعد از انتخاب كل مسير * 
 :شوددر خط فرمان دستور زير ظاهر مي* 

Select reference point (Enter for start): 

 .را فشار دهيد Enterيك بار ديگر * 
 .شودباز مي 1-5اي مطابق شكلپنجره* 
 
 
 
 
 
 
 
 

، نام و توصيف مسير را به دلخواه وارد كرده و كيلومتراژ شروع مسيـر  Define Alignmentي ظاهر شده با نام در پنجره*  
 .كنيد Okپنجره را . است را تغيير ندهيد 0.000فرض، كه بصورت پيش

 . شودكيلومتراژ ابتدا و انتهاي مسير در خط فرمان ظاهر مي* 

 ي مسيررسم كناره -6

دار كرده را تيك  Outer offset، ) 1-6شكل( ي ظاهر شدهرا اجرا كرده و در پنجره  Alignments> Create Offsetدستور* 
متر اسـت     11مثلا اگر عرض كل مسير .  چپ و راست آن، مقدار نصف عرض مسير را وارد كنيد offsetو سپس در بخش 

دار كرده و براي چپ و راست، نصف عـرض كـل       را تيك  Inner offsetحال قسمت .  را وارد كنيد 5/5در هر قسمت عدد 
 .را وارد كنيد 3/6متر است براي هر بخش عدد  7/2مثلا اگر عرض كل آسفالت . آسفالت را وارد كنيد

 

 ، تعريف مسير افقي1-5شكل
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 گذاري مسيرايستگاه -7

،          ) 1-7شـكـل  ( ي ظـاهـر شـده       را اجـرا كـرده و در پـنـجـره                  Alignments> Station Label Settingدستـور    *  
Perpendicular labels دار كرده و در قسمت را تيكStation label increment     وStation tick increment     ي فـاصـلـه

متر 10ها متر و در قوس20متر به 20متر، در كوهستان 50متر به 50معمولا در دشت . ها را وارد كنيدزني ايستگاهبرچسب
 .گذاري شودمتر ايستگاه 10متر به  10، يعني 10وارد كردن عدد . متر10به 
 .كنيد Enterرا اجرا كرده و سه بار   Alignments> Create Station Labelsدستور * 
ي مـتـن را در مـنـوي                                   لازم به ذكـر اسـت كـه اگـر كـاربـر بـخـواهـد انـدازه                        .  شودگذاري ميمسير برچسب*  

Format> Text Style  هـا اعـمـال شـود بـايـد دسـتـور                      ايسـتـگـاه      كه اين تغيير روي بـرچسـب  عوض كند، براي اين
Alignments> Create Station Labels  را دوباره اجرا كند. 

 معرفي چند منوي مهم -8
 *Alignments> Set Current Alignment  :خواهيد وارد پروژه شـويـد     بنديد و دوباره ميهر بار كه برنامه يا پروژه را مي

 .كنيد OKي باز شده مسير خود را انتخاب كرده و كردن در صفحه Enterبايد اين دستور را اجرا كنيد و پس از 
 *Terrain> Set Current Surface   : ي بـاز شـده       در هر ورود جديد به پروژه لازم است پس از اجراي دستور در پنجـره

 .كنيد OKسطح ساخته شده را انتخاب و 
*Alignments> Alignment commands> Multiple Selections  :افزاربراي پاك كردن يك يا چند مسير از نرم 

 *View> Regen All  :هاي مسير حالت شكسته داشتنـد  كه قوسدرصورتي.  ي خودبراي برگرداندن اشكال به حالت اوليه
 .از اين دستور استفاده كنيد تا به حالت اول برگردند

 ي مسير ، تعريف كناره1-6شكل
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 رسم ارتفاعات زمين و پروفيل طولي -9

را  Loadي را انتخاب كرده و گزينه  Civil Designي باز شده،را اجرا كرده و در صفحه  Projects> Workspaceدستور * 
 .كليك كنيد

ي بــاز شــده در قســمــت                               اجــرا كــرده و در پــنــجــره           را  Profiles> Profile Setting> Samplingدســتــور   *  
Sample offset tolerance  در بخش . را وارد كنيد 0/5عددSample lines ،يگزينه  Import                را بدون تيـك كـنـيـد تـا

چپ و راست،  offsetدار كرده و براي را تيك  Sample left/rightقسمت . ها نشودهاي زياد اين قسمت وارد منوي لايهلايه
 .كنيد Okپنجره را ). 1-9شكل(براي هر كدام نصف عرض كل راه را وارد كنيد

ابـتـدا يـك                   Layer Prefixرا اجرا كرده و در قسـمـت             Profiles> Profile Setting> Labels and Prefixدستور * 
 )Profile*مثلا (وارد كرده و سپس نام دلخواه را وارد كنيد) ستاره( *

در .  كـنـيـد    Okي ظاهر شده را را اجرا كرده و پنجره  Profiles> Existing Ground> Sample From Surfaceدستور* 
 .كنيد Enterهر دو را . شودخط فرمان پرسش ايستگاه ابتدا و سپس انتهاي مسير ظاهر مي

 .كليك كنيد Yesي ظاهر شد، روي گزينه ?Vertical alignment already exists, retain finish surfacesاگر پيغام * 
 .شودبرداري از مسير ظاهر ميدر خط فرمان پيغامي مبني بر نمونه* 
ي   گـزيـنـه      Profile Creation Parametersدر بخش .  را اجرا كرده Profiles> Create Profile> Full Profileدستور * 

Left to Right و ) براي رسم پروفيل از چپ به راست(دار كردهرا تيكImport Left/Right Profile     را بدون تيك كـنـيـد
ي      گـزيـنـه   ).  كـنـد  افزار سه پروفيل خط وسط، چپ و راست راه را رسـم مـي          دار كردن اين گزينه نرمدر صورت تيك( 

Import Grid ي افقي، قائم و ارتفاع گريدها را برحسب نظر خود براي پرينت گرفتن، وارد كنيـد دار كرده و فاصلهرا تيك .
 .كنيد Okبعد از وارد كردن اعداد، پنجره را ). 2-9شكل(را وارد كنيد 1و  5،  20توانيد ترتيب عنوان راهنما ميبه

 زني مسير ، برچسب1-7شكل
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 :شوددر خط فرمان پيغام زير ظاهر مي* 
Select starting point: 

دقت كنيد اين نقطه را در جايي انتخاب كنيد ( ي شروع پروفيل را روي صفحه با يك بار كليك موس انتخاب كردهنقطه*  
هـاي قـبـلـي،                  و در خط فرمان در پاسخ به سوال پاك كـردن پـروفـيـل      )  كه روي آنچه قبلا در صفحه رسم شده، نباشد

No  را تايپ كرده وEnter  اگر قبلا پروفيل طولي رسم كرده باشيد با فرمان ( كنيدYes  به جايNo را پـاك     توانيد آنمي
 ).كنيد

 .شودافزار رسم ميوضعيت زمين طبيعي توسط نرم* 
ي هاي ميزان انجام شد و مطابق نـكـتـه   اگر بعد از رسم پروفيل عوارض زمين تغييري در نقاط يا ارتفاعات منحني:  نكته*  

را )  رسم ارتفاعات زمين و پروفيـل طـولـي     (10اين تغييرات را وارد و سطح را دوباره ساختيد، لازم است گام  12ي صفحه
 .براي سطح جديد دوباره تكرار كنيد

چرخانده و سپس بـا     Rotateها را با دستور توانيد يكي از شمارهها در هم رفته است، ميي ايستگاهدر صورتيكه شماره*  
 .ها را بچرخانيدي شمارههمه Match Propertiesدستور 

 .رسدبعد از رسم پروفيل عوارض زمين، نوبت به رسم خط پروژه مي* 
 

 برداري از مسير ي نمونه،تنظيمات پنجره1-9شكل

 ، ساخت پروفيل 2-9شكل
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 هاروش كيلومتراژ ايستگاه -2روش دستي  -1. در اين مرحله براي رسم خط پروژه دو روش وجود دارد* 
 :ها لازم است در كشيدن خط پروژه نكات زير را در نظر بگيريدقبل از توضيح اين روش* 
 .هاي خط پروژه از حدود مجاز تجاوز نكندشيب -1
 .هاي مسطح حداقل شيب طولي رعايت شوددر زمين -2
 .خط پروژه از نقاط اجباري پروژه بگذرد -3
 . ي قوس افقي قرار گرفته و بر آن منطبق شودقائم در محدوده براي ايجاد ديد بهتر سعي كنيد قوس -4
 ).اي قرار گيرندي دايرهتوانند روي قوس سادههاي قائم ميولي قوس(هاي كلوتئيد قرار نگيرندهاي قائم روي قوسقوس -5
 .هاي افقي تيز در قوس قائم پرهيز كنيداز قرارگرفتن شروع قوس -6
 .بين خاكبرداري و خاكريزي تا حدودي تعادل برقرار باشد -7

 هاي قائم و افقي ، طراحي خوب و بد قوس3-9شكل

هاي   انطباق خوب قوس
 )طراحي خوب(قائم و افقي

 

كاهش ديد راننده به دليل 
ي قوس قائم در قرارگيري قله

 )طراحي بد(شروع قوس افقي

 

هاي ناهماهنگي بين قوس
قائم و افقي، و قوس افقي 

 )طراحي بد(خمپشت

 

 )طراحي بد(قوس قائم بدون قوس افقي )طراحي بد(قوس قائم بدون قوس افقي

 )طراحي خوب(قوس افقي بدون قوس قائم
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هاي زيـر ظـاهـر      در خط فرمان پيغام.  را اجرا كنيد  Profiles> FG Centerline Tangents> Create Tangentsدستور* 
 .كنيد Enterيكي ها را يكيآن. شودمي

Select point (or Station): 
 
Station <0.000>: 
 
Elevation <2170.000>: 

 . شودشود به ابتداي پروفيل عوارض زمين متصل ميخطي كه با موس هدايت مي* 
 :شوددر خط فرمان پيغام زير ظاهر مي* 

Select point [Station/eXit/Undo/Length]: 

 :   روش دستي -1
كـنـد،   ي بعدي خط پروژه را طـلـب مـي         را كه نقطه :Select point [Station/eXit/Undo/Length]پيغام * 

 :ي كار به اين شرح استنحوه. دهيممستقيما با انتخاب نقطه در صفحه پاسخ مي
شود و ابتداي آن به ابتداي پروفيل عوارض زمين متصل است، همان خط پروژه است كه بـا    خطي كه در صفحه ديده مي

هاي مـوردنـظـر      بنابراين قادر خواهيد بود با كليك موس روي ايستگاه.  شودكليك موس در هرنقطه روي پروفيل ثابت مي
هاي افـقـي   هاي ابتدا و ميانه و انتهاي قوسولي لازم است قبل از اين كار ابتدا كيلومتراژ ايستگاه.  خط پروژه را رسم كنيد

ها و مـوارد      ساده يا كلوتئيد و نقاط اجباري پروژه را از روي پلان يادداشت كرده و سپس با توجه به كيلومتراژ اين ايستگاه
نقاط شكستگي خط پروژه يا هـمـان     .  كنيمكنترل و ويرايش مي 18را در گام  2و1موارد .  خط پروژه را رسم كنيد 7تا  3

لازم به ذكر است كه رسم خـط پـروژه از       .  شوندطراحي مي 11هاي قائم هستند كه در گام نقاط تغيير شيب محل قوس
درضمن در رسـم دسـتـي روشـن بـودن                      .  ي راهسازي است و به دقت زيادي احتياج داردهاي پروژهمهمترين قسمت

Nearest  وEndpoint وقتي به پايان پروفيل رسيديد . تواند مفيد باشددر صورت نياز ميEnter كنيد. 
در خط فرمان  :Select point [Station/eXit/Undo/Length]كه پيغام بعد از آن: هاروش كيلومتراژ ايستگاه -2

 :شودپيغام زير ظاهر مي. كنيد Enterرا در خط فرمان تايپ كرده و  Sظاهر شد، حرف 
Enter station: 1495 

 :شودپيغام بعدي وارد مي. كيلومتراژ ايستگاه موردنظر را وارد كنيد
Select point [Grade/Elevation/Undo/eXit]:  

:    كـنـد  افزار شيب خط پروژه را بين ايستگاه اول و اين ايستـگـاه طـلـب مـي         كنيد نرم Enterرا وارد كرده و  Gاگر حرف 
Grade (%):  . عدد شيب را با درصد تايپ وEnter در سـرازيـري داريـد وارد كـنـيـد              %  5مثلا اگـر شـيـب        .  كنيد             :

Grade (%): -5 .كندافزار اين تكه از خط پروژه را رسم مينرم. 
 .مانند قبل عمل كنيد. شودظاهر مي :Select point [Station/eXit/Undo/Length]دوباره پيغام
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را وارد كـنـيـد،                Eحـرف      Gجاي به :Select point [Grade/Elevation/Undo/eXit]كه در جوابدرصورتي
 .كندخواهيد خط پروژه در اين ايستگاه به آن وصل شود طلب مياي را كه ميافزار ارتفاع نقطهنرم

افـزار        را وارد كـنـيـد نـرم       Lحرف  :Select point [Station/eXit/Undo/Length]در ضمن اگر در جواب پيغام
 .كندي بعدي خط پروژه برسيد طلب ميخواهيد جلو رويد تا به نقطهجاي كيلومتراژ، طول افقي را كه ميبه
ي رسـم خـط       مورد ذكر شده دربـاره  7كنيد، سعي كنيد دقت كنيد از هر روشي كه براي رسم خط پروژه استفاده مي*  

 .خط پروژه را درصورت لزوم ويرايش خواهيم كرد 18در گام . جا كه ممكن است در ترسيم درنظر بگيريدپروژه را تا آن
شـيـب خـط پـروژه و           .  را اجرا كرده و روي هر قسمت خط پروژه كليك كنيد  Profiles> Label> Tangentsدستور*  

كه ارتفاعات زمين و خط پروژه روي هم نيفتند، ابتدا از پروفيل عوارض زميـن يـك     براي اين.  شودارتفاعات آن نوشته مي
سپس عوارض روي پروفيل اصلي را پاك كـنـيـد تـا         ).  براي پرينت(ي ديگري از صفحه قرار دهيدكپي گرفته و در گوشه

 .در اين مرحله شما شيب طولي و ارتفاعات خط پروژه را داريد. ها بنشيندعوارض خط پروژه جاي آن

 هاي قائمطراحي قوس -10

 .دهيمهاي كوژ و كاس انجام ميهاي قائم را براي دو حالت قوسطراحي قوس* 
 )Crestالرأس، محدب، در خط(هاي كوژقوس) الف
 .گيردي حداقل مسافت ديد توقف و مسافت ديد سبقت انجام ميها بر پايهطراحي اين قوس* 
 :حداقل مسافت توقف بدون خطر شامل مجموع دو مسافت زير): Stopping Sight Distance(مسافت ديد توقف* 
كـنـد و     دهد، طي مـي   العمل نشان ميكند و عكسي نقليه از زماني كه راننده مانع را مشاهده ميمسافتي كه وسيله  -1

 .كندبلافاصله بعد از طي اين مسافت ترمز مي
 .كندي ترمز تا توقف كامل طي ميمسافتي كه از لحظه -2

 :شودحداقل مسافت ديد توقف از روابط زير محاسبه مي
 
)10-1 ( 

 .براي حالتي كه سطح جاده بدون شيب باشد
 
 

)10-2 ( 
 . درحالت سربالايي است

 
 
 

)10-3 ( 
 .درحالت سرازيري است

 
 :در اين روابط داريم* 
S =متر(حداقل مسافت ديد توقف( 
V =كيلومتر بر ساعت(ي نقليهسرعت وسيله( 

2 21 V V
S SSD Vt 0.278Vt

3.6 254.2752 f 254f
= = + ≅ +

×

2 21 V V
S SSD Vt 0.278Vt

3.6 254.2752(f G) 254(f G)
= = + ≅ +

+ +

2 21 V V
S SSD Vt 0.278Vt

3.6 254.2752(f G) 254(f G)
= = + ≅ +

− −
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t =ثانيه 2/5بر طبق پيشنهاد آشتو (العملزمان عكس( 
f  =ي نقليه بر روي روسازي جاده كه براي طراحي در حالت روسازي خيس درنظرگرفـتـه   ضريب اصطكاك لاستيك وسيله

 )  2-10و1-10جدول.(شودي ماشين تعيين ميشود، ويا براساس شتاب كندشوندهمي
G =شيب طولي جاده)G مثلا اگر . شوددر فرمول با صدم نوشته ميG=2%  دهيمرا قرار مي 0/02باشد، در فرمول عدد( 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
* AASHTO, “Policy On Geometric Design of  Streets and Highways,” Washington, DC, 1990 and 1994.  

 t=2.5sبا درنظرگرفتن  1-11از فرمول  **
 :آوردبدست مي a=3.4m/s2ي ضريب اصطكاك را با درنظرگرفتن شتاب ثابت كندشونده 2001آشتو * 

 

)10-4( 
 :و براي حداقل مسافت ديد توقف داريم

 
 

)10-5( 
 

 .اين مقادير آمده است 2-10در جدول * 
 

f 
ضريب اصطكاك 
در حالت روسازي 

 *خيس

V(km/h) 

 سرعت طراحي

0/40 30 
0/38 40 
0/35 50 
0/33 60 
0/31 70 

0/30 80 
0/30 90 
0/29 100 
0/28 110 
0/28 120 

S(m) 

ي حداقل فاصله
ديد توقف بهينه 

 **براي طراحي
29/6 
44/4 
62/8 
84/6 

110/8 

139/4 
168/7 
205 

246/4 
285/6 

 ، ضريب اصطكاك و حداقل مسافت ديد توقف1-10جدول 

2V
S SSD 0.278Vt

a
254( G)

9.81

= = +

±

2

2

a(m / s )
f

9.81(m / s
=
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 t=2.5s ،a=3.4m/s2 ،G=0با درنظرگرفتن  5-11از فرمول  *
** AASHTO, “Policy On Geometric Design of  Streets and Highways,” Washington, DC, 2001. 

 

 :هاي كوژ با لحاظ كردن حداقل مسافت ديد توقف دو حالت وجود دارددر طراحي قوس* 
ي طول قوس و مسافت ديد به ايـن صـورت       در اين حالت رابطه.  طول قوس از حداقل مسافت ديد توقف بيشتر باشد  -1

 :است
)10-6( 

 

 :طول قوس از مسافت ديد كمتر باشد -2
)10-7( 

 

 :در اين روابط داريم* 
Lmin =متر(حداقل طول قوس( 
A =درصد(هااختلاف جبري شيب (G1(or g1)=2%  وG2(or g2)=-5% داريم : 

 . را بگذاريد Aدر فرمول مقدار قدرمطلق . براي سرازيري -براي سربالايي و شيب + شيب 
S =متر(حداقل مسافت ديد توقف( 
h1 =متر(ي چشم راننده تا جادهفاصله( 
h2 =متر(ارتفاع مانع( 

 

 .انداين پارامترها نشان داده شده 1-10در شكل * 

2

min 2

1 2

AS
L (L S)

200( h h )
= >

+

2

1 2

min

200( h h )
L 2S (L S)

A

+
= − <

S(m) 

ي حداقل فاصله
ديد توقف  
 *محاسبه شده

V(km/h) 

 سرعت طراحي

31/2 30 
46/2 40 
63/5 50 
83 60 

104/9 70 

129 80 
155/5 90 
184/2 100 
215/3 110 
248/6 120 

S(m) 

ي حداقل فاصله
ديد توقف براي 

 **طراحي

35 
50 
65 
85 
105 

130 
160 
185 
220 
250 

 ، حداقل مسافت ديد توقف2-10جدول 

2 1A G G 5 2 7= − =− − =−
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 .باشد h2=0.15mو  h1=1.07mنمايد كه پيشنهاد مي 1994و  1990آشتو در ويرايش * 
 .باشد h2=0.6mو  h1=1.08mنمايد كه پيشنهاد مي 2001آشتو در ويرايش * 
در .  ، تغيير كرد2001و به طوركلي مسافت ديد توقف در ويرايش جديد آشتو    h1 ،h2 ،aميلادي ضرايب  2001در سال * 
. ميلادي و بعد از آن آمده اسـت    2000جا ضرايب محاسبه و حداقل مسافت ديد توقف براي هر دو حالت قبل از سال اين

ي كلي دو روش بايد گـفـت كـه         به عنوان يك مقايسه.  ها به نظر مهندس طراح بستگي داردانتخاب هر يك از اين روش
  1994و   1990هاي لازم به ذكر است كه استفاده از ضرايب ويرايش.  تر استكارانهمتر محافظهسانتي 15استفاده از ارتفاع 

، 2001كند كه حتي به دو برابر مقادير بدست آمده از ويرايش آشتو براي طراحي قوس قائم، طول قوس بزرگتري ايجاد مي
 .ها كوچكترندآشتو اين مقادير را كم كرده و طول قوس 2001با اين اوصاف ويرايش . رسندمي
در .  استفاده شده اسـت     L>Sدر بيشتر راهنماها از حالت .  كننددو حالت طراحي را بيان مي 7-10و  6-10هاي فرمول*  

 .حالت طراحي استفاده شده است اينجا نيز از اين
 :نوشت Sو  Kاي بين شاخص توان رابطهمي L>Sدر صورت استفاده از حالت * 
 
 

 :رسيمي زير ميشده ي سادهدر فرمول بالا به رابطه h2=0.6mو  h1=1.08mبا جايگزاري * 
)10-8( 
 

 :برابر است با Kطبق تعريف . كندشيب را ايجاد مي% 1ي افقي است كه فاصله Kشاخص : توضيح* 
)10-9( 

  . باشدطول قوس كوژ مي L، 9-10در فرمول 
 :گيرندسرعت طراحي درنظر مي 0/6هاي قائم حداقل طول قوس را برابر براي قوس* 

 

)10-10( 
 

 ) L>S(،حداقل مسافت ديد توقف در قوس كوژ1-10شكل 

2

min 2

1 2

AS
L

200( h h )
=

+
m inL KA=و 

2

2

1 2

S
K

200( h h )
⇒ =

+

2S
K

658
=

L
K

A
=

MinimumCurve Lenght 0.6V=
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 .مقادير لازم جهت طراحي قوس قائم كوژ براساس ضرايب جديد آشتو آورده شده است 3-10در جدول * 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
در طراحي سعي كنيد مقاديري بيشتر از مقـاديـر حـداقـل       .  باشندمقادير ارائه شده براي مسافت ديد توقف، در واقع كمترين مقدار لازم مي *

.            انـد لازم به ذكر است كه مقادير مسافت ديد براي حالت بدون شيب بـودن جـاده بـدسـت آمـده             .  اختيار كنيد تا طراحي خوب و زيبا باشد
ها، مقادير بدون هاي كوژ به دليل وجود سربالاييهرحال در طراحي قوسبه.  كه شيب جاده لحاظ شود اين مقادير متفاوت خواهد بوددر صورتي

. هاي كوژ مقادير اين جدول قابل استفاده و در جهت اطميناننـد بنابراين در طراحي قوس.  شيب از مقادير حاصل از لحاظ كردن شيب بزرگترند
از هميـن  %  3هاي سرازيري ملايم كمتر از هاي كاس بدليل وجود سرازيري و سختي ترمزگرفتن در اين حالت، براي شيبولي در طراحي قوس

 .را بيشتر افزايش داد Sبايد مقادير% 3هاي سرازيري بيشتر از كنيم و در شيبمقادير استفاده مي
 .اندبدست آمده K، مقادير 8-10از ستون دوم همين جدول در فرمول Sبا جايگزيني مقادير  **
*** Lmin(m)=0.6V(km/h) 

 :كندبدين صورت تغيير مي 8-10ي هاي قديمي رابطهدر صورت استفاده از ضرايب ويرايش* 
)10-11( 
 

 .دهدقديمي ارائه مي ضرايب طراحي را در ويرايش 4-10جدول * 

Lmin(m)***
 

 حداقل طول قوس كوژ

K(m/%)** 

شاخص انحنا براي 
 طراحي

S=SSD(m)* 

حداقل مسافت ديد توقف 
 براي طراحي

V(km/h) 

 سرعت طراحي

18 2 35 30 

24 4 50 40 

30 7 65 50 

36 11 85 60 

42 17 105 70 

48 26 130 80 

54 39 160 90 

60 52 185 100 

66 74 220 110 

72 95 250 120 

 )2001ويرايش (ي ديد توقف، پارامترهاي قوس كوژ براي طراحي براساس حداقل فاصله3-10جدول 

2S
K

404
=
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ايـن سـرعـت              .   آيـد برداري با ترافيك سبك به دسـت مـي      گيري سرعت خودروها در حالت بهرهسرعت ميانگين سرعتي است كه از اندازه *

 . درصد سرعت طراحي است 100تا  85بين 
در فرمول   1-10مسافت ديد حداقل براساس سرعت ميانگين، از جايگزيني مقادير سرعت ميانگين و ضرايب اصطكاك ارائه شده در جدول  **
چراكـه رانـنـدگـان در         .  آشتو بر اساس مطالعات اخير خود اعلام كرد كه استفاده از اين مسافت ديد درست نيست.  به دست آمده است 10-1

، سرعت ميانگين و مسافت ديد حاصل از آن 2001به همين دليل در ويرايش سال .  كنندهاي خيس و هواي باراني سرعت خود را كم نميجاده
 ).3-10جدول (را حذف كرد

 .ترندتر و ايمنيكارانهدهد و مقادير بهينه و بيشتر از آن محافظهحالت ميانگين كمترين طول قوس ممكن را مي ***

 :مسافت زير 4اي است شامل فاصله): Passing Sight Distance(حداقل مسافت ديد سبقت* 
 .كندمسافتي كه راننده خود را با شتاب گرفتن براي سبقت از اتومبيل جلويي آماده مي -1
كند و از اتومبيل جلويي سبقت گرفته، به خـط خـود بـاز              مسافتي كه اتومبيل سبقت گيرنده خط خود را عوض مي  -2

 .گرددمي
 .مسافت بين اتومبيل سبقت گرفته بعد از اتمام سبقت، تا اتومبيلي كه از جهت مقابل در حركت است -3
 .مسافتي كه توسط اتومبيل روبرو پيموده شده است -4

 .     ها نشان داده شده استاين فاصله 2-10در شكل* 
شود با اين تفاوت كـه   انجام مي 5-10و  4-10طراحي قوس كوژ با در نظر گرفتن حداقل مسافت ديد سبقت، از روابط *  

h2=1.08m باشد و ميh1=1.08m 2001ويرايش(ماندباقي مي .(h2 ي ماشين روبرو تا سطح ي چشم رانندهجا فاصلهدر اين
استفاده از .  متر است1/07برابر  h1متر و 1/3برابر  h2مقدار ) 1994ويرايش(قديمي در ويرايش). 3-10شكل (باشدجاده مي

در .  كـنـد  پذير نيست و طول قوس را بسيار بزرگ مـي   اي موارد امكانها كوژ، در پارهمسافت ديد سبقت در طراحي قوس
 .  توان اين فاصله را در طراحي وارد كردي كوهستاني نباشد ميهاي طولي كم باشد و راه در ناحيهمواردي كه شيب

K(m/%) 

 شاخص انحنا
 براي طراحي

 ***حداقل-بهينه

K(m/%) 

 شاخص انحنا
 محاسبه شده

 حداقل-بهينه

S=SSD(m) 

مسافت ديد توقف  
حداقل بر اساس 

 **سرعت ميانگين

Vd(km/h) 

 سرعت طراحي

3-3 2/17-2/17 29/6 30 
5-5 4/88-4/88 44/4 40 

10-9 9/76-8/16 57/4 50 
18-14 17/72-13/66 74/3 60 
31-22 30/39-21/92 94/1 70 
49-32 48/1-31/49 112/8 80 
71-43 70/44-42/61 131/2 90 

105-62 104/02-61/01 157 100 
151-80 150/28-79/75 179/5 110 

202-102 201/9-101/9 202/9 120 

Vr(km/h)
 

 *سرعت ميانگين

30 
40 

47 
55 
63 
70 
77 
85 
91 

98 

S=SSD(m) 

مسافت ديد توقف  
بهينه بر اساس 
 سرعت طراحي

29/6 
44/4 

62/8 
84/6 

110/8 
139/4 
168/7 
205 

246/4 

285/6 

 ) 1994و  1990هاي ويرايش(ي ديد توقف ، پارامترهاي قوس كوژ براي طراحي براساس حداقل فاصله4-10جدول 
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 .كنيماستفاده مي L>Sجا نيز از حالت همانند مسافت ديد توقف، در اين* 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 :خواهيم داشت K=LAو با استفاده از تساوي  4-10در فرمول  =h2=1.08m h1با جايگزاري * 
)10-12( 

 :داريم h2=1.3و  h1=1.07mو در حالت * 
)10-13( 

 .آيدبه دست مي 5-11حداقل مسافت ديد سبقت است كه مقادير آن از جدول  Sدر اين رابطه 
 

 ، مسافت ديد سبقت 2-10شكل 

 )L>S(، حداقل مسافت ديد سبقت در قوس كوژ3-10شكل 

2S
K

864
=

2S
K

946
=
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 .كنيداستفاده مي 2001براي زماني كه از ضرايب ويرايش  Sمقادير  *

 .اندبدست آمده K، مقادير 12-10از ستون دوم همين جدول در فرمول Sبا جايگزيني مقادير   **
 .كنيداستفاده مي 1994براي زماني كه از ضرايب ويرايش  Sمقادير  ***
 .اندبدست آمده K، مقادير 13-10از ستون چهارم همين جدول در فرمول Sبا جايگزيني مقادير  ****

 )Sagالقعر، مقعر، در خط(هاي كاسقوس) ب
شوند و سپس بيشتـريـن   هاي جلو و راحتي راننده طراحي ميي ديد چراغهاي كاس براساس دو عامل حداقل فاصلهقوس

 .شودطول قوس به دست آمده از دو روش فوق، انتخاب مي
هاي كاس نسبت به كوژ راننده جلوي خود را بهـتـر   در قوس):  Headlight Sight Distance(هاي جلوي ديد چراغفاصله* 
ها روشنايي كنار جاده وجود ندارد، رانـنـده   ها برخلاف خيابانيابد و چون در جادهبيند ولي اين ديد در شب كاهش ميمي

 ).4-10شكل(هاي خودروي خود قادر به ديدن استفقط توسط نور چراغ

K(m/%)** 

شاخص انحنا براي 
 طراحي

S=PSD(m)* 

حداقل مسافت ديد 
 سبقت براي طراحي

V(km/h) 

 سرعت طراحي

46 200 30 

84 270 40 

138 345 50 

195 410 60 

272 485 70 

338 540 80 

438 615 90 

520 670 100 

617 730 110 
695 775 120 

S=PSD(m)*** 

حداقل مسافت ديد 
 سبقت براي طراحي

217 

285 

345 

407 

482 

541 

605 

670 

728 
792 

K(m/%)**** 

شاخص انحنا براي 
 طراحي

50 

90 

130 

180 

250 

310 

390 

480 

570 
670 

 ي ديد سبقت، پارامترهاي قوس كوژ براي طراحي براساس حداقل فاصله5-10جدول 

 هاي جلوي ديد چراغ، حداقل فاصله4-10شكل 
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ي -زاويه. شودمتر درنظرگرفته مي0/6هاي جلو تا سطح زمين است كه برابر ي چراغفاصله HH، 4-11در شكل* 
جا نيـز دو حـالـت        در اين.  گردددرجه منظور مي) يك( 1مقدار اين زاويه .  سازداي است كه پرتو روشنايي با افق مي،زاويه

 .كنيماستفاده مي L>Sطراحي وجود دارد كه ما از روش 
 

)10-14( 
 
)10-15( 
 

 :داريم 14-11در فرمول و  HHبا جايگزيني مقادير *  
)10-16( 
 

 :خواهيم داشت K=LAو با استفاده از تساوي 
)10-17( 
 

 :داريم) 2-10و  1-10جداول (نامهو با توجه به مسافت ديد حداقل در ويرايش قديم و جديد آيين
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 .اندبدست آمده K، مقادير 17-10از ستون سوم و چهارم همين جدول در فرمول Sبا جايگزيني مقادير  *

α

2

min

AS
L (L S)

200(HH S tan )
= >

+ α

min

200(HH Stan )
L 2S (L S)

A

+ α
= − <

α
2

min

AS
L (L S)

120 3.5S
= >

+

2S
K (L S)

120 3.5S
= >

+

K(m/%) 

 شاخص انحنا
 براي طراحي

 حداقل-بهينه

K(m/%)* 

 شاخص انحنا
 محاسبه شده

 حداقل-بهينه

S=SSD(m) 

مسافت ديد توقف  
حداقل بر اساس 
 سرعت ميانگين

Vd(km/h) 

 سرعت طراحي

4-4 3/92-3/92 29/6 30 
8-8 7/16-7/16 44/4 40 
12-11 11/61-10/27 57/4 50 
18-15 17/2-14/53 74/3 60 
25-20 24/18-19/71 94/1 70 
32-25 31/97-24/72 112/8 80 

40-30 40/06-29/72 131/2 90 
51-37 50/18-36/82 157 100 
62-43 61/80-43/06 179/5 110 
73-50 72/85-49/59 202/9 120 

Vr(km/h)
 

 سرعت ميانگين

30 
40 
47 
55 
63 
70 

77 
85 
91 
98 

S=SSD(m) 

مسافت ديد توقف  
بهينه بر اساس 
 سرعت طراحي

29/6 
44/4 
62/8 
84/6 

110/8 
139/4 

168/7 
205 

246/4 
285/6 

 ) 1994 و 1990ويرايش(، پارامترهاي طراحي قوس كاس 6-10جدول 
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 .اندبدست آمده K، مقادير 17-10از ستون دوم همين جدول در فرمول Sبا جايگزيني مقادير  *
** Lmin(m)=0.6V(km/h) 

 .ايمرسم كرده 10جا خط پروژه را در گام تا اين. پردازيمافزار ميي نرمدر اين مرحله به طراحي قوس قائم كوژ به وسيله* 
 .شودباز مي 5-10اي مطابق شكل پنجره. را اجرا كنيد Profiles> Profile setting> Valuesدستور * 

 )2001آشتو (، تنظيم پارامترهاي طراحي5-10شكل 

Lmin(m)**
 

 حداقل طول قوس كوژ

K(m/%)* 

شاخص انحنا براي 
 طراحي

S=SSD(m) 

حداقل مسافت ديد توقف 
 براي طراحي

V(km/h) 

 سرعت طراحي

18 6 35 30 

24 9 50 40 

30 13 65 50 

36 18 85 60 

42 23 105 70 

48 30 130 80 

54 38 160 90 

60 45 185 100 

66 55 220 110 

72 63 250 120 

 )2001ويرايش (، پارامترهاي طراحي قوس كاس7-10جدول 
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. گذاري براي پروفيل طولي را وارد كنيـد ي ايستگاهفاصله  Stationing Increments، در قسمت 5-10ي شكل در پنجره* 
در قسـمـت               .  وارد كنيد تا خـودبـخـود صـفـر شـود              0.0001هاي كاس و كوژ را هر دو مقدار قوس  K Valueدر بخش 

Sight Distance Value   مقدار عددي ارتفاع چشم راننده و ارتفاع جسم از سطح جاده را در دو حالت سبقـت )Passing  (               و
پنجره را ).  6-10و5-10هايشكل( هاي جديد يا قديم آشتو وارد كنيدبا توجه به انتخاب يكي از ويرايش)  Stopping( توقف
Ok كنيد. 

 
 
 
 
 
 
 
 
 
 
 
 

 Landافـزار    نرم 2000مربوط به ورژن  5-10افزار است و شكلنرم 2004مربوط به ورژن  6-10ي شكلپنجره:  توضيح*  
جا وارد در اين  Headlight angleو   Headlight heightدو قسمت  2004شود در ورژن طور كه مشاهده ميهمان. باشدمي

فرض برنامه صحيح بوده و نياز به تغيير ، اين اعداد در پيش2004يا  2000به هر حال در صورت استفاده از ورژن .  اندشده
 .در قسمت قوس كاس توضيح داده شدند Headlight angleو   Headlight height(HH)مقادير   .  نيست

 .شودباز مي 7-10اي مطابق شكلپنجره. را اجرا كنيد Profiles> FG Vertical Curvesدستور * 
 .هاي كوژ و كاس ارائه شده استهاي مختلف طراحي قوسدر اين پنجره روش* 
 :كنيمگونه عمل ميبراي طراحي قوس كوژ اين* 
 .به دست آوريد 10-10ييا رابطه 3-10براساس سرعت طراحي، حداقل طول قوس را از جدول -1
، L=KAي   به دست آورده و با استفاده از رابطه 4-10يا  3-10را از جدول  Kبراساس سرعت طراحي، مقدار شاخص   -2

 .مقدار طول قوس را به دست آوريد
 .به دست آوريد 4-10يا  3-10را از جدول ) S(براساس سرعت طراحي، حداقل مسافت ديد توقف -3
 :دوحالت ممكن است Lو  Sي با مقايسه -4
 .به ترتيب زير عمل كنيد. باشد L>S: حالت اول -4-1

 .كنيد Okكليك كرده و پنجره را  Lengthي روي گزينه* 
 :شوددر خط فرمان پيغام زير ظاهر مي* 

Select incoming tangent: 
 

 )1994آشتو (، تنظيم پارامترهاي طراحي6-10شكل 

( )α
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 .روي مماس ورودي قوس كوژ كليك كنيد* 
 :شوددر خط فرمان پيغام زير ظاهر مي* 

Select outgoing tangent: 

 .روي مماس خروجي قوس كوژ كليك كنيد* 
 .اند، سمت چپي مماس ورودي و سمت راستي مماس خروجي استبين دو مماس يا خطي كه قوس كوژ را ساخته* 
 :شوددر خط فرمان پيغام زير ظاهر مي* 

Length of curve:  

دقت كنيد اگرچـه زيـاد     .  را به بالا گرد كرده يا عددي بيشتر از آن را وارد كنيد 2عدد طول قوس به دست آمده از گام*  
 Enterدر خط فرمان،   Lبعد از وارد كردن .  بردي پروژه را نيز بالا ميدهد ولي هزينهشدن طول قوس ايمني را افزايش مي

 .كنيد
Length of curve: 270 

 .كنيد Escبراي خروج از دستور . شودقوس طراحي شده رسم مي* 
در اين حالت نيز مانند حالت اول عمل كنيد با اين تفاوت كه عدد طول قوس را بزرگتـريـن   .  باشد  L<S:  حالت دوم  -4-2

 . افزار كنيدانتخاب كرده و همانند بالا وارد نرم 2و1هاي عدد به دست آمده از گام
توانيد طول قوس كـوژ  ، مي) ي كوهستاني نباشدهاي طولي كم باشد و راه در ناحيهشيب( كه شرايط اجازه دهددرصورتي*  

 5-10و جـدول       13-10يا  12-10با اين تفاوت كه از روابط . را با درنظرگرفتن حداقل مسافت ديد سبقت طراحي كنيد
گام را عينا مثل طراحي قوس كوژ براساس حداقل مسافت ديد توقف كه قبلا گفته شد، انجام بهاستفاده كنيد و مراحل گام

 .مثل بالا وارد كنيد :Length of curveسپس طول حاصل را در جواب پيغام. دهيد
 .هر تعداد قوس كوژ كه در پروفيل طولي داريد را به همين روش طراحي كنيد*  
 

 ، طراحي قوس قائم7-10شكل 
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همانند قبل، بعد از تعريف پارامترهاي طراحي مـطـابـق    .  پردازيمافزار ميي نرمهاي كاس به وسيلهحال به طراحي قوس* 
 :كنيمبه ترتيب زير عمل مي 7-10ي ، و باز كردن پنجره6-10و  5-10هاي شكل

 .  به دست آوريد 10-10ي يا رابطه 7-10براساس سرعت طراحي، حداقل طول قوس را از جدول  -1
، L=KAي   به دست آورده و با استفاده از رابطه 7-10يا  6-10را از جدول  Kبراساس سرعت طراحي، مقدار شاخص   -2

 .مقدار طول قوس را به دست آوريد
 .به دست آوريد 7-10يا  6-10را از جدول ) S(براساس سرعت طراحي، حداقل مسافت ديد توقف -3
 .هاي كاس به دست آوريدرا براساس معيار راحتي راننده در قوس Lمقدار  18-10با استفاده از رابطه -4
)10-18( 

 .، سرعت طراحي برحسب كيلومتر بر ساعت استVدر اين رابطه 
، بزرگترين را انتخاب كرده و همانند طراحي قـوس كـوژ در         4و2و1هاي هاي به دست آمده از گاماز بين طول قوس  -5

 .افزار كنيدمراحل قبل، اين طول قوس را وارد نرم
هـاي  كه قادر به طراحي انواع قـوس علاوه بر اين AutoCAD Land Development And Civil Designافزارنرم: توضيح* 

هاي قائم را نيز براساس معيارهاي مختلف طراحي، محـاسـبـه و طـراحـي                ، قوس...) ساده، چند مركزي، شبدري و ( افقي
افـزار و    كه به درك بالايي از نرمافزار علاوه بر اينها به نرمها، يعني سپردن كامل طراحيولي استفاده از اين روش.  كندمي

شـود،  افزار آشنـا مـي    هاي طراحي احتياج دارد، يك روش آزمون و خطاست و براي كسي كه اولين بار با اين نرمنامهآيين
ي راهسازي در حد تئوري براي دانشجويان كارشناسي، احتياج به شناخـت كـامـل      چراكه انجام يك پروژه.  مناسب نيست

به همين دليل در اين راهـنـمـا از        .  ي پروژه نيز مشكلي نداشته باشندپارامترهاي طراحي دارد تا اين عزيزان در مصاحبه
هاي افقي شود و بسيار سريع است، خودداري شد و طراحي قوسافزار انجام ميهاي طراحي كه تنها توسط نرمآوردن روش

به عنوان يك نكته بد نـيـسـت بـدانـيـد در                  .  افزاري ارائه شدهاي دستي و نرمكلوئتيد و قائم به صورت تركيبي از روش
هاي قائم را با درنـظـرگـرفـتـن        ي طراحي قادر خواهيد بود قوسنامهافزار براحتي با انتخاب آيينهاي جديد اين نرمنسخه

هاي بعدي اين راهنما اين موارد نيز لحـاظ خـواهـد      در ويرايش. عوامل دخيل بيشتري مانند زهكشي مسير، طراحي كنيد
 .شد
آشتـو   2001و كاس از روش ويرايش )  براساس حداقل مسافت ديد توقف(هاي كوژكه براي طراحي طول قوسدرصورتي* 

و                           )  بـراي قـوس كـوژ       (   8-10ي نـمـودارهـاي اشـكـال         هـاي خـود را بـه وسـيلـه             توانيـد جـواب    استفاده كنيد، مي
ها و محور افـقـي طـول      يا اختلاف شيب Aدر اين نمودارها محور عمودي پارامتر .  كنترل كنيد)  براي قوس كاس(   10-9

 Kاعداد روي نمودارها نيز مقادير سرعت طراحي برحسب كيلومتر بر ساعت و پـارامـتـر      .  باشدقوس قائم برحسب متر مي
 .باشندمي
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 ، كنترل طراحي طول قوس قائم كوژ8-10شكل 

V=30 

K=2 

V=40 

K=4 

V=50 

K=7 

V=60 

K=11 

V=70 

K=17 

V=80 

K=26 

V=90 

K=39 

V=100 

K=52 

 

16 

14 

12 

10 

8 

6 

4 

2 

0 
0 100 200 300 400 500 600 

LENGTH OF CREST VERTICAL CURVE (m) 

A
 (
%
)

 

 ، كنترل طراحي طول قوس قائم كاس9-10شكل 
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 هاي قائمبرچسب زدن به قوس -11

ورودي، سپس شيب خروجـي و    )  مماس( را اجرا كرده و ابتدا روي شيب  Profiles> Labels> Vertical Curvesدستور* 
در قوس قائـم   Aهمان مقدار   .A.Dجا در اين. شوداطلاعات قوس قائم ظاهر مي. در انتها روي خود قوس قائم كليك كنيد

مثلا اگر داشته . شوندبرحسب درصد بيان مي 1gو 2g . شيب ورودي است 1gشيب خروجي و  2gكه  1g-2g=A: است و داريم
 :، خواهيم داشت)علامت منفي يعني شيب سرپاييني( g2=-5%و   )علامت مثبت يعني شيب سربالايي( g1=+2%باشيم 

A=-5-2=-7 

 افزاربه نرم) هاي قائمقوس+خط پروژه(معرفي مسير قائم -12

ي  هاي صفحه بجـز لايـه    كل لايه.  را اجرا كرده  Profiles> FG Vertical Alignment> Define FG Centerlineدستور* 
از    به ترتيبهاي خط پروژه را حال به ترتيب از نزديكي ابتداي خط پروژه شروع كرده و تكه.  شوندخط پروژه خاموش مي

دقت كنيد كه مسير قائم تـنـهـا شـامـل        .  شودچين ميي انتخاب شده خطبا هر كليك، تكه.  چپ به راست انتخاب كنيد
ي قوس بوده و جـزو مسـيـر          ي سومهدهندههاي قائم است و علامت مثلث و دو خط دو طرف آن نشانها و قوسمماس

 .شوددر ضمن با اولين كليك در ابتداي مسير، يك علامت ضربدر در شروع خط پروژه ظاهر مي. نيستند
شود كه اين عدد مـجـمـوع تـعـداد          نشان داده مي PVIدر خط فرمان تعداد .  كنيد  Enterها، ي تكهبعد از انتخاب همه* 

 .هاي ابتدا، انتها و رأس هر قوس قائم استنقطه

 برداري از زمين براي مقاطع عرضينمونه -13

ي بـاز شـده          را اجرا كـرده و در پـنـجـره             Cross Sections> Existing Ground> Sample From Surfaceدستور* 
در قسـمـت               .  مـتـر وارد كـنـيـد            40برداري چپ و راسـت را          ، عرض نمونهSwath Widthsدر بخش ) 1-13شكل(

Sample Incrementsافزار قادر است حتـي بـه          نرم.  ي مقاطع عرضي را وارد كنيدبرداري و يا همان فاصلهي نمونه، فاصله
طوركلي مقـاطـع   به.  اين انتخاب به صورت پروژه و نظر مهندس بستگي دارد. متري، مقاطع عرضي ايجاد كند 1هاي فاصله

هايي كه شكل مقـطـع عـرضـي عـوض               ها، و نقاط خاصي مانند نقاط اجباري پروژه و يا در محلعرضي در محل ايستگاه
 .شوندشود، مثلا وقتي از يك كيلومتراژ به بعد عرض راه عوض شود، زده ميمي

ي                           تـوانـيـد گـزيـنـه        هاي خاص نـيـز مـقـطـع عـرضـي تـولـيـدكـنـد، مـي                     افزار در ايستگاهدر صورتيكه بخواهيد نرم
Add specific stations دار كنيدرا تيك. 

 .كنيد Okدار كرده و پنجره را را تيك Importي ، گزينهSample Linesدر بخش * 
 ي اضـافـه    پيغام سوم درباره.  كنيد  Enterشود، اين دو را در خط فرمان پيغام ابتداي مسير و سپس انتهاي آن ظاهر مي* 

دار كرده باشيد، اين پيغـام ظـاهـر      را تيك  Add specific stationsاگر . هاي بحراني يا خاص استي ايستگاهكردن شماره
توانيد بـا اجـراي       هاي دلخواه را ميي ايستگاهشماره( كنيد  Enterهاي موردنظر را وارد و هر بار ي ايستگاهشماره.  شودمي

 ).ي مورد نظر به دست آوريدو كليك كردن روي مسير در نقطه Alignment> Station/Offset> Labelدستور 
. كنـيـد    Enterرا در خط فرمان تايپ و سپس  Yيا  Yesي در خط فرمان، كلمه Overwriteي پيغام در صورت مشاهده* 

 .برداري را قبلا نيز براي مسير انجام داده باشيدشود كه عمل نمونهاين فرمان زماني ظاهر مي
 :شودبرداري از مسير ظاهر ميدر خط فرمان پيغام نمونه* 

 
You have sampled sections for 2615.696 meters of alignment. 
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 معرفي الگوي روسازي -14

افزار حاضر قادر است الگوي روسازي را همراه با مشخص كردن نوع مواد روسازي از كاربر دريافت كرده و در مقاطـع  نرم*  
.  كندها رسم ميهمچنين محاسبات دوِر را انجام داده و الگوي روسازي را براساس اين محاسبات در قوس.  عرضي وارد كند

ي احجام خاكي در ابتدا بصورت اوليه و تقريبي محاسبه شده و در مراحل بعدي تـوسـط گـروه        جا كه محاسبهولي از آن
شوند، و نيز براي سادگي كار و پرهيز از مطرح كردن مسائل روسازي بردار دقيقا برداشت شده و در محاسبات وارد مينقشه

شود، دراين راهنما الگوي روسازي به صورت يك خط صاف يـعـنـي    هاي واقعي توسط تيم مخصوص انجام ميكه در پروژه
 :مراحل كار به شرح زير است. سطح بستر راه روي خط پروژه نشان داده شده است

براي اين كار . ي ترسيم، يك خط افقي به طولِ نصف عرضِ كل راه رسم كنيدرا اجرا كرده و در صفحه Polylineدستور * 
ي اول خط را تعيين كرده و سپس با موس خط را در حـالـت     كافي است بعد از اجراي دستور با كليك روي صفحه، نقطه

 .كنيد Enterافقي نگاه داشته، عدد نصف عرض راه را در خط فرمان وارد كرده و 
 :در خط فرمان داريم. را اجرا كنيد Cross Sections> Templates> Define Templateدستور * 

Pick finish ground reference point: 

 ).روشن باشد Endpointبهتر است (ي انتهايي خط در سمت راست كليك كنيدروي نقطه* 
 :شودپيغام متقارن بودن الگو ظاهر مي* 

Is template symmetrical [Yes/No] <Yes>: 

 ).پذيرش متقارن بودن(كنيد Enterپيغام را * 
 :در خط فرمان داريم* 

Select template surfaces... 
Select objects: 

 .كنيد Enterروي خط كليك كرده و * 
Select objects: 1 found 

 برداري از زمين براي مقاطع عرضي، تنظيمات نمونه1-13شكل 
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 :در خط فرمان داريم* 
Surface type [Normal/Subgrade] <Normal>: 

 .كنيد Enterرا انتخاب و پنجره را ) ايدانه(Granularي باز شده كرده و در پنجره Enterپيغام را * 
 :در خط فرمان داريم* 

Pick connection point out: 

 .ي ابتدايي خط در سمت چپ كليك كنيدروي نقطه* 
 :كنيد Enterرا  آن. شودظاهر مي) هاگذاري نقطهشماره(پيغام زير* 

Datum number <1>: 

 :در خط فرمان داريم* 
Pick datum points (left to right): 

.    كـنـيـد      Enterي انتهايي سمت راست خط كليك كـرده و      ي ابتدايي سمت چپ و سپس روي نقطهابتدا روي نقطه*  
 .كنيد Enterي باز شده را نيز پنجره

پيغام بعـدي   .  جواب داده و نام دلخواه را براي الگو در خط فرمان وارد كنيد Yesي الگو ظاهر شده، آن را با پيغام ذخيره* 
 .پاسخ دهيد Noمبني بر ساخت الگويي ديگر را با 

 .الگوي روسازي تعريف و ذخيره شد* 

 معرفي پارامترهاي طراحي -15
شيب شيرواني عاملي است كه توسط پارامترهايي چون مقاوت برشي خاك و عمق خاكبرداري يـا    :  شيب شيرواني  -15-1

ي عمودي واحد درنـظـرگـرفـتـه          ي افقي و عمودي، كه فاصلهاين شيب نسبتي است بين فاصله.  شودخاكريزي تعيين مي
جـا دو    در اين.  اي محاسبه كندافزار حاضر قادر است شيب شيرواني را در سه حالت ساده، برحسب عمق و پلهنرم.  شودمي

 .هاي درسي كاربرد بيشتري دارد، آمده استحالت عمق و ساده را كه در پروژه
مـثـلا شـيـب                          .  شـود در اين حالت براي تمام مقاطع عرضي راه يك شيـب يـكـسـان تـعـريـف مـي              :  حالت ساده)  الف
 .خواهند بود 1:3كه تمام مقاطع عرضي راه داراي شيب يعني اين) 3به1(1:3
 ).1-16شكل(در اين روش شيب شيرواني براي يك مقطع ثابت نيست: ايحالت پله) ب
 
 
 
 
 
 
 
 
  
 
 
 اي، شيب شيرواني پله1-15شكل  
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چگونگي ايـن  .  كنددر اين حالت برحسب تغييرات عمق خاكبرداري يا خاكريزي، شيب شيرواني تغيير مي:  حالت عمق)  پ
شود، شيب شيرواني با درنظرگرفتن مقاومت برشي خاك و اي است كه هرچه عمق عمليات خاكي زياد ميگونهتغييرات به

تغييرات عمق و شيب با نظر مهنـدس طـراح     .  يابد تا حجم عمليات خاكي تا حدودي كمتر گرددعوامل ايمني افزايش مي
 .گرددمنظور مي

كه از روش ساده استفاده كنيد در مراحل بعدي تنظيمات آن انجام خواهد شد ولي اگر از روش عمق استفـاده  درصورتي*  
 :مراحل كار به شرح زير است. كنيد، لازم است جدول مربوط به تغييرات عمق و شيب را تشكيل دهيدمي
 .شودباز مي 2-15اي مطابق شكل پنجره. را اجرا كنيد Cross Sections> Design Control> Depth Slopesدستور * 
 :ي اين جدول بدانيدقبل از مثال لازم است نكاتي درباره. جا مثالي آورده شده است تا مطلب بهتر بيان شوددر اين* 
 .اولين عمق بايد صفر باشد -
 .شوداعمال مي) در جدول عمق پاييني(شيب روبروي هر عمق، از آن عمق تا عمق بعدي -
كه عمقي خارج از اين ترتيب وارد شود به طور خودكار در شوند و در صورتيها هميشه بصورت مرتب شده وارد ميعمق  -

 .گيردجاي صحيح قرار مي
اين دو گزينـه مـربـوط بـه چـگـونـگـي                       .  را بدون تيك كنيد Pin overrideو  Vertical depth measureي دو گزينه -

 .باشندفرض بدون تيك ميگيري عمق و اتصال شيب شيرواني به زمين طبيعي هستند و به طور پيشاندازه
 .را يكسان وارد كنيد Typicalو  Maxمقدار شيب  -

 .نگاه كنيد 2-15و شكل  1-15براي اين كار به جدول . افزار كنيمهاي زير را وارد نرمخواهيم جدول شيبمي: مثال* 

ارتفاع 
خاكبرداري يا 

 )متر(خاكريزي

شيب شيرواني 
 )قائم:افقي(

1/5-0 1:5 

3-1/5 1:3 

4/5-3 1:2/5 

6-4/5 1:2 

 1:1/5 6بيش از 

 ،جدول شيب شيرواني برحسب عمق2-15شكل 

 ، شيب شيرواني 1-15جدول 
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در اين مثال براي وارد كردن آخرين عدد جدول، مقداري انتخاب شده كه بيشترين عمق خاكبرداري يا خـاكـريـزي را      *  
ي حداكثر عمق خاكبرداري يا خاكريزي از مـقـايسـه       .  متر اطمينان حاصل شود 6ها براي بيشتر از دارد تا از اعمال شيب

توانيد عددي بزرگ را به دلخواه وارد كنيد كه در عين حال مي.  آيدپروفيل عوارض زمين و خط پروژه براحتي به دست مي
 .مطمئن هستيد از حداكثر عمق بيشتر است

توانيد اين اعداد درصورت متفاوت بودن مي. هاي شيرواني يكسان بوددر اين مثال عمق خاكبرداري و خاكريزي در شيب* 
 . وارد كنيد Fillو  Cutهاي را در ستون

 Okهـا را      ي رنج ايستگـاه پنجره.  را اجرا كنيد   Cross Sections> Design Control> Edit Design Controlدستور *  
 .را كليك كنيد Template Control، )3-15شكل (ي كنترل طراحيكنيد و در پنجره

 
 
 
 
 
 
 
 
 
 
 
 
 

را كليك كرده و از بين الگوها، الگويي را كه در گـام  )  در سمت چپ( Selectي گزينه)  4-15شكل ( ي باز شدهدر پنجره*  
 .كنيد OKساخته شد، اتنخاب كرده و  15
 .را كليك كنيد Slopesي گزينه) 3-15شكل (ي اين بار در پنجره* 
اگر از روش سـاده اسـتـفـاده                  .  افزار معرفي كنيمبايد مقادير شيب شيرواني را به نرم)  5-15شكل ( در پنجره باز شده*  
براي هر چهار حالت خاكبـرداري و خـاكـريـزي در چـپ و راسـت، روش                                 5-16كنيد، كافي است همانند شكل مي

وارد شـده   3اين عدد  5-15در شكل .  در قسمت شيب شيرواني عدد مربوط را وارد كنيد.  را انتخاب كنيد)  Simple( ساده
ها نصف عرض كل راه را وارد كنيد و ساير گزينه Offsetدر قسمت .  است 1:3است يعني براي تمام مقاطع شيب شيرواني 

 .بدون تيك باشند 5-15مثل شكل 
كـه شـامـل سـاده،                             5-15ي كشـويـي شـكـل           در صورت استفاده از روش عمق كافي است اين حالت را از پنجره*  

طور خودكار از   افزار بهنرم.  را وارد كنيد 1اي است انتخاب كنيد و در قسمت عدد شيب شيرواني، عدد و پله)  Depth( عمق
 .كندوارد كرديد استفاده مي 2-15اعدادي كه در شكل 

 .كنيد OKهاي بعدي را نيز كه مربوط به پردازش است كرده و پنجره OKرا  3-15و  5-15هاي در پايان پنجره* 

 ، تنظيم پارامترهاي طراحي3-15شكل 
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اين خـطـاهـا اعـلام            .  ، روي آن كليك كنيد تا خطاها ديده شوندView Errorsاي با عنوان ي پنجرهدر صورت مشاهده*  
افـزار شـيـب      رسيده، نـرم   ي شيب شيرواني به انتهاي خط زمين نميكه ادامهها به دليل آنكند كه در بعضي ايستگاهمي

براي كاهش اين خطاها كافي است .  كندشيرواني را در مورد اين ايستگاه تا حدي كه به انتهاي خط زمين برسد، تندتر مي
بــيــشــتــر كــنــيــد ولــي فــرمــان                                                                                 40بــرداري را از          عــرض نــمــونــه         1-13در شــكــل        

Cross Sections> Design Control> Process Sections را اجرا كنيد تا مقاطع با تغييرات جديد دوباره پردازش شوند . 

 ، انتخاب الگو4-16شكل 

 ، نتظيمات شيب شيرواني5-16شكل 
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 رسم جدول احجام خاكي -16

 .را اجرا كنيد  Cross Sections> Total Volume Output> Volume Tableدستور * 
يـعـنـي     Prismoidalي براي واژه P.  كردن پاسخ دهيد Enterدر خط فرمان و  Pي احجام را با تايپ پيغام نوع محاسبه* 

 .تر استكند كه حالت منشوري دقيقافزار به دو صورت ميانگين و منشوري احجام را محاسبه مينرم. منشوري بكار رفته
 .كنيد Yes ،Enterها را با پيغام تصحيح در قوس* 
در صورت وجود اين ضرايب در صورت پروژه، پيغام را با  .  كندپيغام بعدي كاربرد ضرايب انقباض و انبساط را پرسش مي*  
Yes ،Enter شوددر خط فرمان پيغام زير وارد مي. كنيد: 

Cut adjustment factor <1.00>: 1.16 

باشد و در حالتي استـفـاده   مي 1فرض عدد طور پيشاين ضريب به .  كندپيغام بالا ضريب تصحيح خاكبرداري را طلب مي
طور مثال ضريب انبسـاط خـاك،     كه براي پروژه به درصورتي.  شود كه در پروژه ضريب انبساط خاك لحاظ نشده باشدمي
در واقع كافي اسـت  .  وارد نماييد 1/16شود درنظرگرفته شده باشد، فاكتور تصحيح را همانطور كه در بالا مشاهده مي%  16

 .كنيد Enterبعد از وارد كردن ضريب . جمع كنيد 1تقسيم كرده و با  100درصد ضريب را بر 
 :شوددر خط فرمان پيغام زير وارد مي* 

Fill adjustment factor <1.00>: 1.1 

وارد    1/1درنظرگرفته شده است، فاكتور تصحيح را     %  10جا هم مانند بالا اگر در پروژه مثلا ضريب انقباض خاك در اين
 .كنيد Enterرا بپذيريد و مانند بالا  1فرض برنامه يعني در غير اين صورت عدد پيش. كنيد

هاي ابتدا و انتـهـاي   كردن، پيغام Enterاي روي صفحه براي رسم منحني بروكنر انتخاب كرده و با سه بار در انتها نقطه*  
 .شودمنحني بروكنر رسم مي. ها و مقياس منحني بروكنر را جواب دهيدايستگاه

شيب صعودي به معناي خاكبرداري .  در اين منحني بخش خاكبرداري بالا و بخش خاكريزي پايين محور افقي قرار دارد*  
 .است -و علامت خاكريزي + در واقع علامت خاكبرداري .و شيب نزولي خاكريزي است

براي ايـن كـار     .  توانيد محاسبات عمليات خاكي را بصورت فايل متني نيز داشته باشيدعلاوه بر رسم منحني بروكنر مي*  
را اجرا كنيد و به دستورات خط فرمان كه همـانـنـد رسـم         Cross Sections> Total Volume Output> To Fileدستور 

در فايـل    Land Projectاين فايل در قسمت .  كنيد Enterدر پايان نام فايل را انتخاب و .  منحني بروكنر است، پاسخ دهيد
قرار بگيريد اين مسير در قسـمـت       File> Openاگر يك بار در منوي .  اي كه در گام اول ساختيد، ذخيره شده استپروژه

Project Path  اين فايل را با . شده استمشخصWordpad  ياNotepad باز كنيد. 

 ويرايش خط پروژه  -17

ي پـروژه       ي حمل متوسط، دو عامل مهم در بحث هـزيـنـه   دانيد دو عامل حجم عمليات خاكي و فاصلههمانطور كه مي*  
ي حجم عمليات خاكي را در اين گام و فاصله.  آوردي پروژه را پايين ميكردن اين دو عامل هزينهباشند و كمراهسازي مي

كه از حد هاي خط پروژه را درصورتيدر اين مرحله قادر خواهيد بود كه شيب. كنيمكنترل مي 19متوسط حمل را در گام 
هرحال هر تغييري كه روي خـط پـروژه     به.  هاي قائم را عوض كنيدمجاز تجاوز كرده باشند تصحيح كنيد و يا محل قوس

توانـيـد بـا      در اين بخش مي.  شودانجام دهيد سبب تغيير در احجام خاكبرداري و خاكريزي و درنتيجه منحني بروكنر مي
شود، تعادل بيشتري بين خاكبرداري و خاكريزي ايجاد كرده و كه ايمني مسير حفظ مياعمال تغييرات درست علاوه بر آن

است كه در  4-17تا  1-17ي مرحله 4ويرايش خط پروژه شامل .  جا كه امكان دارد كم كنيدحجم عمليات خاكي را تا آن
 . ادامه آمده است
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را    Profiles> FG Vertical Alignment> Editكنيد، دستور افزار استفاده مينرم 2000ي كه از نسخهدر صورتي -17-1
ي گزينه Vert. Alignmentدر اين پنجره در قسمت بالا از كشوي . در صفحه ظاهر شود 1-17ي شكل اجرا كرده تا پنجره

FG Center  افـزار، ابـتـدا در مـنـوي                                    و بـه بـعـد نـرم             2004ي   در صورت اسـتـفـاده از نسـخـه           . را انتخاب كنيد
Profiles> Edit Vertical Alignment در قسـمـت      ) 2-17شكل   ( ي باز شدهقرا گرفته و در پنجره ،Finished Ground 

 . باز شود 3-17ي شكل كنيد تا پنجره OKرا انتخاب و  Center ي گزينه
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 ، ويرايش مسير قائم1-17شكل  

 ، انتخاب مسير قائم 2-17شكل 
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، تغيير ايستـگـاه رأس قـوس                ) Grade%( هابراي ويرايش مسير ابزاري مثل تغيير شيب 3-17و  1-17ي شكل در پنجره
)PVI Station(تغيير ارتفاع رأس ،)Elevation (روش استفاده از ايـن  .  ها را در اختيار داريدكردن تعداد قوسو اضافه يا كم

 . پذير استي مربوطه امكانابزار بسيار ساده و تنها با وارد كردن عدد موردنظر در خانه
تغـيـيـر    .  ماندكنند ولي طول قوس ثابت ميها تغيير مي، شيب3-17يا  1-17ي شكل بعد اعمال هر تغييري در پنجره*  

بنـابـرايـن لازم اسـت         .  همراه خواهد بود Sو در نتيجه  K، و تغيير اين پارامتر با تغيير Aها به معناي تغيير پارامتر شيب
ها را مـطـابـق    ، قوسAبهترين روش در اين حالت اين است كه با پارامتر جديد .  پارامترهاي طراحي بار ديگر كنترل شوند

هاي قائم آمد، دوباره طراحي كرده و طول قوس جديد را مـحـاسـبـه و وارد كـنـيـد                                آنچه كه در بخش طراحي قوس
كنيد، در افزار استفاده مينرم  2000براي وارد كردن طول قوس جديد اگر از ويرايش ).  ي بعد توجه كنيدبه مثال صفحه( 

. را كليك كنيـد   Edit Curveي ها كليك كرده و گزينهي مربوط به طول قوس يكي از قوسدر خانه 1-17ي شكل پنجره
ي           در اين پنجره بعد از طراحي مجدد قـوس، مـقـدار جـديـد را در خـانـه                   .  شودباز مي 4-17اي مطابق شكل پنجره

Curve Length وارد و  پنجره اينEnter  كنيد و باNext  ياPrev در پايـان  . به قوس بعدي رفته و همين كار را تكرار كنيد
 .را كليك كنيد Yesي تغييرات، ي پيغام ذخيرهكنيد و سپس در پنجره OKپنجره را 
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جـديـد      Aجا نيز طول قوس را با پارامتر افزار، همانند بند قبل در اينو به بعد نرم 2004در صورت استفاده از ويرايش *  
كـه  در صـورتـي    .  كنيد Enterوارد و  3-17ي شكل پنجره  Curve Lengthحساب كرده و طول قوس جديد را در قسمت 

شود كه محاسبات قوس قائـم را     كليك كنيد، در انتهاي پنجره قسمتي اضافه مي 3-17را در شكل  Calculatorي گزينه
افـزار بـا انـتـخـاب                هاي جديد نـرم شود، نسخههمانطور كه در اين شكل ديده مي.  دهدحساب انجام ميمثل يك ماشين

ولي همانطور كه پيش از اين گفتـه شـد بـراي ايـن كـه                    .  كنندي طراحي، قوس قائم را طراحي و محاسبه مينامهآيين
هاي بعدي اين راهنمـا  ها خودداري شد ولي در ويرايشهاي آموزشي اين راهنما بيشتر شود از پرداختن به اين روشجنبه

 :جا براي راهنمايي بيشتر يك مثال طراحي آمده استدراين. خواهد آمد
 :فرض كنيد براي يك قوس كوژ داريم* 

A=9.08,V=60km/h  
 :بر طبق سرعت طراحي داريم) آشتو2001طراحي براساس ويرايش (2-10از جدول 

S=85m,K=11,Lmin=36m 

باشد پس طول قوس انتخابي را   مي  L>Sچون .  L=9.08*11=99.88m: آيدبراي طول قوس بدست مي L=KAبا توجه به 
 :گيريمبه همين منظور عددي بيشتر از آن را درنظرمي. تعيين كرد L=99.88mبايد براساس 
L=120m ها يا هر تغييري داشته باشيمحال فرض كنيد بعد از ويرايش شيب. كنيمرا انتخاب كرده و وارد مي :A=12. 

 :كنيمحال دوباره مثل قبل براساس سرعت طراحي همان پارامترهاي قبلي را استخراج مي
S=85m,K=11,Lmin=36m 

 .كنيمو طول قوس جديد را وارد مي L=150mكنيم انتخاب مي. L=11*12=132m: داريم L=KAبا توجه به 
 .احتياج بود L=132mطول قوس و در حالت دوم به  L=99.88mبه  S=85mدر واقع در حالت اول براي رسيدن به حداقل 

 

 هاي قائم، كنترل پارامترهاي قوس4-17شكل 
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 .گرديمي پروسه برميبعد از ايجاد تغييرات در مسير قائم، به ادامه* 
ي كنيد تا تغييرات وارد صفحه Enterرا اجرا كرده و دو بار  Profiles> FG Vertical Alignment> Importدستور -17-2

 .نمايش شود
را اجرا كنيد تا تغييرات خط پروژه در مقـاطـع     Cross Sections> Design Control> Process Sectionsدستور  -17-3

 .عرضي وارد شود
را اجرا كنيد تا منحني بروكنر جـديـد      Cross Sections> Total Volume Output> Import Mass Haulدستور  -17-4

 .رشم شود
براي اين كار بايد بـا  .  همانطور كه گفته شد هدف در اين مرحله تصحيح خط پروژه و كاهش حجم عمليات خاكي است*  

،           ...) هـا و      مثل تـغـيـيـر شـيـب        ( جا در اختيار داريدو ابزاري كه در اين 10ذكر شده در گام  6تا  1در نظرگرفتن موارد 
هرچه اين تعادل بيشتر شود حجم عمليات خاكي كمتر .  يعني تعادل خاكبرداري و خاكريزي بيشتر كار كنيد 7روي مورد 

درپي از خاكبـرداري بـه     دهد احجام را پيجا كه شرايط اجازه ميايجاد تعادل در پروفيل طولي يعني بايد تا آن.   گرددمي
در اين حالت منحني بروكنر متناوبا تغيير علامت داده و يكسره به صورت صـعـودي يـا        .  خاكريزي و بالعكس تبديل كرد

در نتيجه نقاط حداكثر سطوح بالا و پايين منحني بروكنر يعني مقادير حداكثـر خـاكـبـرداري و         .  كندنزولي حركت نمي
 .ي تكراري داردبه صورت يك پروسه 4-17تا  1-17اين كار به تمرين و تكرار مراحل .  كنندخاكريزي، كاهش پيدا مي

 ي متوسط حملتعيين فاصله -18
ي حـمـل     ي فاصلـه بعد از رسيدن به منحني بروكنر نهايي و ويرايش خط پروژه، بايد خط پخش بهينه را براي محاسبه*  

 . گيريمبراي اين كار دو حالت را درنظر مي. متوسط پيدا كنيم
در اين حـالـت بـهـتـريـن                 .  شود براي محل قرضه و دپو هيچ محدوديتي نداريمدر اين حالت فرض مي:  آلحالت ايده  -1

ي خطي موازي خط اساس كه از نـقـطـه   ( و خط پاياني)  محور افقي منحني بروكنر( خط پخش خطي است بين خط اساس
معمولا .  هاي سطوح بالا و پايين خط پخش مساوي شوندكه سبب شود مجموع قاعده)  شودپاياني منحني بروكنر رسم مي

 :آيدكه اين حالت برقرار نباشد سه وضعيت زير بوجود ميدرصورتي. پذير نيسترسيدن به اين حالت هميشه امكان
هاي سطوح بالا و پايين منحني بروكنر مسدود به خط پخش، وقتي خط پخش از خط اسـاس بـه     تفاوت بين قاعده  -1-1

 .در اين حالت بهترين خط پخش همان خط اساس است. شودكند، مرتباً بزرگ ميسمت خط انتهايي منحني حركت مي
هاي سطوح بالا و پايين منحني بروكنر مسدود به خط پخش، وقتي خط پخش از خط اسـاس بـه     تفاوت بين قاعده  -1-2

در اين حالت بهترين خـط پـخـش      .  گرددشود ولي صفر نميكند، مرتباً كوچك ميسمت خط انتهايي منحني حركت مي
 .همان خط انتهايي است

هاي سطوح بالا و پايين منحني بروكنر مسدود به خط پخش، وقتي خط پخش از خط اسـاس بـه     تفاوت بين قاعده  -1-3
اين وضعيت زماني پيـش  .  دهدكه صفر گردد ناگهان تغيير علامت ميكند، بدون آنسمت خط انتهايي منحني حركت مي

 .منطبق است) ي افقيقطعه(در اين مورد خط پخش بر اين خط افقي. اي افقي باشدآيد كه منحني بروكنر شامل قطعهمي
دانيد ممكن است خاكي كه از خاكبرداري بـه  همانطور كه مي:  هاي قرضه و دپوتعيين خط پخش با درنظرگرفتن محل  -2

آيد از نظر مشخصات خاك براي خاكريزي مناسب نباشد و احتياج به قرضه داشته باشـيـم و يـا لازم بـاشـد                    دست مي
 . هاي اضافي خاكبرداري را در جايي ذخيره كنيم و در واقع به محل دپو احتياج داشته باشيمخاك
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توان محل قرضه يا دپو را بـه  البته نمي.  بنابراين لازم است محل دقيق قرضه يا دپو را روي منحني بروكنر مشخص كرد*  
محل قرضه يا دپـو  .  ي ساخت راه داردسنجي منطقهدلخواه در طول پروژه تعيين كرد و اين كار احتياج به مطالعه و امكان

و    Bمعمولا قرضه را با حرف .  دهندرا با كشيدن دو خط موازي عمودي در ايستگاه مربوطه روي منحني بروكنر نشان مي
لازم بـه    .  آيدبراي پيدا كردن خط پخش در اين وضعيت حالات مختلف زير به وجود مي.  دهندنشان مي Dدپو را با حرف 

 .شوداستفاده مي Lineافزار از دستور ذكر در تمامي اين حالات براي رسم خط پخش در محيط نرم
 .در اين حالت بهترين خط پخش خط اساس است. محل قرضه يا دپو در سمت راست منحني بروكنر واقع باشد -2-1
 . در اين حالت بهترين خط پخش خط پاياني است. محل قرضه يا دپو در سمت چپ منحني بروكنر واقع باشد -2-2
و خـط     1-2در اين حالت خط پخش سمت چپ مثل حالت .  محل قرضه يا دپو در وسط منحني بروكنر واقع باشد  -2-3

 .باشدمي 2-2پخش سمت راست مثل حالت 
در اين حالت خط بخش بين خط اساس و خط پاياني وجود .  محل قرضه يا دپو در طرفين منحني بروكنر واقع باشد  -2-4

 .آيدحالت زير به وجود مي 4دارد و 
هـاي  آيد كه مجموع قاعدهكند، موقعيتي پيش ميوقتي خط پخش از خط اساس به سمت خط پايان حركت مي  -2-4-1

در اين حالت همين خط، خط پخش بـهـيـنـه       .  شوندسطوح بالا و پايين منحني بروكنر مسدود به خط پخش مساوي مي
 .است

آيد كـه تـفـاوت بـيـن                  كند، موقعيتي پيش ميوقتي خط پخش از خط اساس به سمت خط پايان حركت مي  -2-4-2
دراين حالت خط اساس بهتريـن  .  شودهاي سطوح بالا و پايين منحني بروكنر مسدود به خط پخش، مرتبا بزرگ ميقاعده

 .خط پخش است
آيد كـه تـفـاوت بـيـن                  كند، موقعيتي پيش ميوقتي خط پخش از خط اساس به سمت خط پايان حركت مي  -2-4-3

در ايـن    .  گـردد شود ولي صفر نـمـي  هاي سطوح بالا و پايين منحني بروكنر مسدود به خط پخش، مرتبا كوچك ميقاعده
 .حالت بهترين خط پخش خط پاياني است

آيد كـه تـفـاوت بـيـن                  كند، موقعيتي پيش ميوقتي خط پخش از خط اساس به سمت خط پايان حركت مي  -2-4-4
دهد و اين بـه  كه صفر گردد تغيير علامت ميهاي سطوح بالا و پايين منحني بروكنر مسدود به خط پخش، بدون آنقاعده

 . در اين حالت خط پخش بر همين خط افقي منطبق است. ي افقي در منحني بروكنر استخاطر وجود يك تكه
در اين صورت خـط پـخـش      .  دپو و قرضه به طور متعدد به جز در ابتدا و انتها، بر روي منحني بروكنر موجود است  -2-5

ي ابـتـدايـي در      و براي تكه.  است 4-2براي تمام قطعاتي كه در بين دو محل قرضه يا دپو قرار دارند مثل يكي از حالات 
اگر علاوه بر نقاط مياني، در ابتـدا و    .  2-2ي انتهايي در سمت راست مانند حالت و براي تكه 1-2سمت چپ مانند حالت 

 .است 4-2ها مثل يكي از حالات ي قسمتانتهاي منحني بروكنر نيز قرضه يا دپو داشته باشيم در اين حالت همه
در اين وضعيت ابتدا بايد منحني بـروكـنـر را        .  انددپو يا قرضه در ابتدا و انتهاي منحني با فاصله از آن تعيين شده  -2-6

ي ابتدايي و انتهايي منحني خطي موازي خط اساس رسم كنيم تا به محل قرضه يا دپو متصل كه از نقطهيعني آن.  ببنديم
پـس از رسـم، بـرحسـب مـورد از يـكـي از                                      .  افزار استفاده كـنـيـد   در محيط نرم Lineبراي اين كار از دستور .  شود

 . كنيمحالات ذكر شده در قبل استفاده مي
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دراين حالت بايد محل قرضه يا .  باشداز يك نقطه يا ايستگاه مسير، خارج از محور راه مي dي دپو يا قرضه به فاصله  -2-7
به سمت چپ و  dي يا ايستگاه، منحني بروكنر را جدا كرده و به فاصله دپو را در آن نقطه يا ايستگاه قرار داد و از آن نقطه

ي منحني بروكنر را با دو خط افقي به محل قرضه يـا دپـو       سپس نقاط جدا شده.  راست آن نقطه يا ايستگاه انتقال دهيم
 .كنيمحال برحسب مورد از يكي از حالات ذكر شده در قبل استفاده مي. كنيموصل مي

 Moveو براي انتقال آن از دستور   Break at Pointيا Breakي موردنظر از دستور براي جدا كردن منحني بروكنر از نقطه
 .توان استفاده كردمي
رسم كـرديـد، بـا اسـتـفـاده از               7-2تا  1-2ي منحني بروكنر نهايي را با توجه به موارد كه خط پخش بهينهبعد اين*  

 :كنيمي حمل را محاسبه ميگيري مساحت و طول در اتوكد فاصلهدستورات اندازه
ي ظـاهـر شـده        در پنجره.  را انتخاب كنيد Inquiryي باز شده ي اتوكد راست كليك كرده و در صفحهدر بالاي صفحه  -

Area دستور .  را كليك كنيدArea   كـنـد  ، مساحت يك سطح را با كليك كردن موس روي نقاط محيط آن محاسبه مـي .
روي    Endpointبنابراين براي هر كدام از سطوح بالا و پايين منحني بروكنر از يك نقطه شروع كرده و با روشـن بـودن       

در خط فرمان مسـاحـت ايـن        .  كنيد Enterخطوط دور هركدام از سطوح حركت كرده و دوباره به جاي اول باز گرديد و 
 .شودسطح داده مي

ي سطح زير منحني بروكنـر يـا     دهندههر عدد نشان.  اين كار را براي تمام سطوح انجام داده و اين اعداد را يادداشت كنيد
 .باشدمجموع اين اعداد عزم حمل كل مي. است) S(عزم حمل

حال براي هر سـطـح   .  يا خطي را انتخاب كنيد Linearرا فراخوانده و سپس حالت  Dimensionمثل بالا اين بار دستور   -
هر عدد ارتفاع سطح مسدود . گيري كنيدي هر سطح تا خط افق را اندازهترين نقطهبالا و پايين منحني، از بالاترين يا پايين

 .است) V(به منحني بروكنر يا حجم خاك
 :را به دست آوريد) برحسب متر(ي حمل متوسطمقدار فاصله 1-18از فرمول  -
)18-1( 

 )چاپ(پرينت -19

ي اتـوكـد وجـود دارد و                       هايي كه تا پايان كار در صـفـحـه       توانيد از تمام ترسيمي راهسازي ميبراي تكميل پروژه*  
هاي دستي و محاسبات احجام خاكي كه وارد فايل متنـي  در ضمن طراحي.  ي مراحل كار است، پرينت بگيريددهندهنشان

 .ي متني اتوكد فراخوانديد، پرينت بگيريدهاي افقي كه را در صفحهكرديد و نيز مشخصات قوس
و   Verticalهـاي    مـقـيـاس   ،    Scaleدر قسمت   Project > Drawing Setupبراي نمايش مقاطع عرضي ابتدا در منوي * 

Horizontal  وارد كنيد 5000را. 
تك و يا در يك صـفـحـه وارد        توانيد مقاطع را تكدر اين منو مي.  را اجرا كنيد  Cross Sections> Section Plotدستور
هـمـچـنـيـن          .  انجام دهيد تا شكل مربوطه مورد دلخواه شما بـاشـد    Text Styleو  Settingsتنظيمات را در قسمت . كنيد

قـرار گـرفـتـه و در جـواب پـيـغـام                                       Cross Sections> Section Utilities> Label Slopeتوانيد در مـنـوي         مي
Type of text placement [Auto/Manual]:   حرفA  را در خط فرمان تايپ وEnter ي سپس روي نقـطـه  .  كنيد

. شودشيب شيرواني در صفحه وارد مي.  خواهيد كليك كنيدپايين و بالاي شيب شيرواني هر كدام از مقاطع عرضي كه مي
توانيد عمق خاكبرداري يـا خـاكـريـزي را         مي Cross Sections> Section Utilities> Label Depthهمچنين در منوي 

  .مشخص كنيد

m

S
d

V
=
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بـراي  .  بندي كرده و هر تيپ را در يك صفحه پرينت بـگـيـريـد    ها را تيپبه دليل تعداد زياد مقاطع عرضي، بهتر است آن
و  2004هاي كنيد و يا در   نسخه) …Save As(در اتوكد ذخيره dwgها را با فرمت توانيد فايلپرينت هر شكل دلخواه مي

 .توانيد اين كار را انجام دهيدمي File> Export to AutoCADبه بعد، در منوي
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